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Getting Started

Introduction
What HandNet

Does
HandNet for Windows lets you control and monitor many connected
HandKey readers. In this one program, you can control who can use each
reader and when. You can also monitor activity and alarms for all readers
at once.

Registering
HandNet

After the first time you use this version of HandNet, you have 14 days to
register it.  You must register it even if you registered your previous version
of HandNet.  If you don't register it within 14 days, you won't be able to log
into the program.  The process should only take a minute.

1. If you haven’t logged into HandNet yet, log in; see
page 4.

2. If the registration screen isn’t shown, pick Register
from the File menu, and click the Print the
registration form button on that screen.

3. Fill the form out and fax it to the number at the top of
the form.  Once we receive your completed form, we'll
fax an activation code back to you within two business
days.  (Since it could take two days for us to send your
code back, please print and send the registration form
now; don't wait until day 14.)

4. Pick Register from the File menu, enter the activation code we sent, and
click the Activate button.  Once you do this, HandNet is permanently
functional.

New Features
in Version 2.0

HandNet for Windows version 2.0 provides a number of new features, but
these are only available to you if you purchased the upgrade to the full
feature set.  If you didn't purchase this upgrade and you would like to,
please contact your dealer; once you pay for the upgrade, we’ll send you a
new access code to enter on the Registration screen.  Once you enter this
code, all the new features are immediately available to you.

How to tell if I
have access

to the new
features

1. From the main menu bar, click the Help menu, and then click About
HandNet for Windows.

2. Check the bottom of the box that pops up.  To be able to use the new
features, the last line must say You may use all features of this software.
If this line says Your current license does not let you use the enroll....,
you must contact your dealer and upgrade your license before you can
use the new features.  (Once you upgrade, we’ll send you an access code
that makes these feature available.)
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The new
features

Enrolling Users from HandNet:  Previously, to enroll a user, you had to go to a
reader, enter command mode on the reader, and enroll the user.  Now,
if you have a reader that is near the computer, you can add the user in
HandNet, select the reader to enroll at, and pick Enroll from the Reader
menu without ever having to deal with command mode on the reader;
see page 88. 

User Access for a Limited Time Period:  HandNet now lets you specify that a
user's access should start and stop at certain days or times.  For
example, if a contractor needs access to your facility, you can now set
the access to expire on the day that the contract ends.  This gives you
more complete control of who can access readers and when.  See
page 93.

Import/Export Users:  If you have more than one computer system running
HandNet and you want users added on one system to be available to the
others, HandNet now lets you export user information from one
program and import it into another; see page 99.

Exporting Activity for External Report Generation:  If you want to create custom
activity reports using some external report tool, Export Activity on the
File menu sends all of your current activity to an access database file
called expactvt.mdb; see page 117.  While the main HandNet database
files are password protected for security reasons, this file is not, so you
can open it and access any information in it at will.  You can also set
HandNet up to automatically export activity whenever you archive
activity.

�����
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Getting Help in HandNet
The on-line help has the same information that’s in this manual.  To get
help in HandNet, press F1.  This brings up help for the screen you’re on.
From there, you can use the contents, index, or search tabs at the left of the
help window to find any topic.

For Basic
Topics

Click the Contents tab at the top of the left pane, click a book to open, and
then click a topic.  Not every topic is in the Contents though, so if you don't
find what you need, try the Index or Search tabs.

For Groups of
Topics on a

Single Theme

In addition to the contents you can also click on the pull-down list right
under the Previous/Next buttons (in the bottom middle of the header).  This
list contains a number of important groups of topics.  Once you are on one
of these topics, the Next and Previous buttons work as well.

Screens and
Menus

On menus and screens in this help, click any option on the screen to jump
to help on that item.

When to Use
the Index and

When to
Search

Use the index for main themes like adding a reader or enrolling a user.  Use
search for minor points.  For example, if you type “enroll” on the index tab,
you get three main topics that deal with enrolling users.  On the search tab,
“enroll” gets you nearly 30 topics where “enroll” appears somewhere in the
text.  For main topics, the index gets you to what you want more directly.
On the other hand, if you remembered that a screen somewhere said
something about the number of tries a user got before having access denied,
the search tab would check the entire text and find this detail for you.  Use
the index tab to find items that are likely to be a main topic; use the search
tab to find minor points.

Marking a
Topic to

Return To

To mark a topic in the help that you want to come back to:

1. Go to the topic that you want to mark.
2. Click the Favorites tab at the top of the left pane.
3. Click the Add button at the bottom of the pane.  This adds the topic to

your favorites list.

To get back to any marked topic later:

1. Click the Favorites tab at the top of the left pane of the help window.
2. Double-click the topic.

�����
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Getting In and Getting Out

Starting
HandNet

To start HandNet, either click the HandNet icon on your Windows desktop
or click the Start menu on your Windows taskbar, highlight Programs, and
highlight and click HandNet for Windows.

Logging into
HandNet

HandNet requires you to log in before you can make any changes; this
prevents unauthorized people from changing information.  If you aren't
logged in, you can look at the lists of activity, users, and readers (network),
but you can't change any information and can't use any other options.

1. Click Login on the Toolbar or pick
Login from the File menu.  The
program brings up this box:

2. Type your Name and Password and
click OK.

If this is a new system:  Use a Name of
“1234” and a Password of “new.”  (Change this name and password
immediately so unauthorized people can't user the program.)

After initial setup:  If you forget your Name or Password, see your
supervisor or security administrator.

Passwords are NOT case sensitive.  For example, if your password were
narnia, then Narnia and NARNIA would also work.

After you are done using HandNet, be sure to log out again so unauthorized
operators won't be able to use the program.

Changing the
Initial Login

Name and
Password

HandNet comes set up with a login name of 1234 with a password of NEW.
This lets you get into HandNet when you first start using it, but this isn’t
secure; anyone may read this manual and find this name and password.  To
keep unauthorized users from using HandNet, change this password before
you add any other information.

1. Click the View menu.
2. Click Settings.
3. Click the Operators tab.
4. Click the operator named 1234 and then click Edit.  This takes you to

the Operator Definition screen which has settings for this user.
5. Change the Name to your name, and change the Password to something

you will remember but that no one else will be able to guess.  Then click
OK to return to the list of operators.

Remember the Name and Password you enter; if you forget it, you won't
be able to get into HandNet.  Don't change any other settings; this user
is set up to use any option in HandNet; if you uncheck any boxes, you
won't be able to use the corresponding options.

6. Click the Close button at the bottom of the box to close the System
Settings.
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Logging Out of
HandNet

When you are done using HandNet, log out of HandNet.  This prevents
unauthorized people from changing information.  (Someone who isn't logged
in can look at the lists of activity (including alarms), users, and readers but
can't change any information or use any other options.

To log out, click the Logout button on the Toolbar or pick Login again from
the File menu to uncheck it.

Exiting
HandNet

For security purposes, you should generally log out of HandNet when you
are done making changes (so unauthorized people can't add users or make
changes).  However, unless you are going to install a new version of the
HandNet software or you need to restart the computer HandNet is running
on, you don't typically want to Exit from the HandNet program.  If you exit
(that is, shut down the program), you disconnect it from all readers.  While
all readers will continue to record activity and give access as appropriate,
the program won't receive any information from the readers or process any
alarms during the time that HandNet isn't running.  Because of this, you
would usually leave HandNet running all the time.

�����
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Getting Started Overview

Procedure for
Getting Started
and Setting Up
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Getting Started with HandNet for Windows

1. Log in; see page 4.
2. If you haven't done so yet, register HandNet.  HandNet won't let you log

in after 14 days if you don't register it.  See page 1.
3. Change the initial password so unauthorized users won't be able to use

the program; see page 4.
4. If you have been using readers without HandNet and you want to get

the users from the reader(s):
1. Pick Settings from the View menu.
2. Click the Security tab.
3. Check the box by Do not delete unauthorized enrollments.

This prevents HandNet from deleting the users from the readers when
you enable them.  (You’ll import the users from the reader later, after
setting up the readers and sites.)  If you didn't change this setting,
when you enabled the site and reader, HandNet would regard all of the
users in the reader as unauthorized (because they weren't in HandNet
yet) and it would delete them from the reader.

5. Set up site(s), that is, groups of connected readers; see page 33.
6. Set up readers; see page 41.
7. If you want to control which days and times users can access readers,

set up time zones (see page 62) and holidays (see page 66).
8. If you have set up time zones and holidays, or if you want to give some

users access through some readers but not others, set up access profiles;
see page 68.

9. If you have previously been using one of our older MS-DOS products
(HandNet Plus or HandNet), convert the users; see page 98.  (If you've
been using HandNet for Windows 1.09 or later, you don't need to
convert anything; this version of HandNet automatically updates
information for the new version.)

10. If you have been previously using readers without one of the HandNet
products and you need to get users from the reader(s), upload users
from the reader(s); see Getting User Information from a Reader on
page 99. 

11. Add users; see page 75.
12. Enroll the users; see page 88.
13. When you are done using HandNet, be sure to log out so unauthorized

people won't be able to add or change anything; see page 5.



Menus and Navigation

Toolbar The toolbar looks like this.

If you aren’t logged in yet, the first button will be a login button and a
number of the other will be disabled.

Turning the
Toolbar On

and Off

Toolbar on the View menu turns it on or off.

Options on the
Toolbar

You see this button if you aren’t logged in yet.  Click this button
to login to HandNet; see page 4.  Without logging in, you can’t
make any changes or do anything other than look at basic
information. 

Once you log in, the first button changes to the Logout button.  If
you are going away from the computer, logging out prevents
making unauthorized changes.  If anyone could possible get access
to the computer in your absence, logging out is an important
security precaution.

The main button here lets you generate a custom activity report;
see Creating a Custom Activity Report from the Reports Menu on
page 105.  The small arrow to the right pulls down the reports
menu; see page 13.

This lets you archive older activity; see page 115.

This opens the activity window; see page 101.  The activity
window lists all actions you take in HandNet and actions or
alarms from each reader.  If the activity window is already open
and behind another window, this brings it to the front.

This opens the users window; see page 72.  This lists everyone
who is potentially able to access readers.  If the users window is
already open and behind another window, this brings it to the
front.

The opens the network window; see page 31.  The network
window lists all of your sites and readers and their current status.
If the network window is already open and behind another
window, this brings it to the front.

This takes you to the access profile settings; see page 68.  Access
profiles let you control which readers different types of users have
access to and when.
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This takes you to the holidays settings; see page page 66.  If users
have different access on holidays than on other days, the holidays
settings identify when those days are.

This takes you to the settings that let you define different periods
of time when users can have access; see page 62.  (In HandNet, we
call these time zones, but there’s no connection to the time zones
we usually think of that have to do with different times around
the world.)

This pops up the on-line help for HandNet.  The help contains the
same information as this manual but arranged in a slightly
different format.  To get help for the screen you are on, you can
also press F1 anywhere in HandNet.  The help has a complete
index and also lets you search for specific text; see page 3.
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Tiling the Display Windows
HandNet lets you keep open the activity window, the users window, and the
network window (which shows sites and readers).  If you have more than
one window open, Tile Horizontally on the Window menu adjusts the open
windows so they fill the Handnet window from side to side and so they don't
overlap and cover each other up.

Example of
Windows that
are NOT Tiled

Notice that the front windows cover up parts of the windows behind them
and that the windows don't fill up the screen from side to side.

Example of
Windows that

ARE Tiled

Notice that none of these windows cover any parts of the other, and that the
windows now fill up the screen from side to side.

�����
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Menu Overviews
Pulling Down

Menus with the
Keyboard

instead of the
Mouse

If you prefer working from the keyboard rather than clicking with the
mouse, you can hold the ALT key down and then type the underlined letter
in the choice.  For example, to open the View menu, you would hold ALT
down and type V.  (This is often the first letter in the option, but it isn't
always.)

Main Menu Bar The main menu bar looks like this:

These menu options are briefly summarized below.  The following pages
contain more detail on the options on these menus.

File:  The File menu lets you log in and out, generate reports, archive older
activity, import setup information, and shut the program down.  See
page 11.

Site:  The Site menu lets you add and change settings for sites (groups of
connected readers); see page 14.

Reader:  The Reader menu lets you add new readers, delete readers, and
rename readers in the HandNet network.  You can also unlock, relock,
and lockup the selected reader, enroll a user at the selected reader,
activate and deactivate an auxiliary device, and send (download) time,
time zones, users, and setup configuration to selected readers.  See
page 15.

User:  The User menu lets you add users, delete users, rename users, change
information for a selected user, and create custom entries to collect
additional information about users; see page 17.

View:  The View menu lets you open the users, activity, and network
windows.  (The activity window lists both activity and alarms; the
network window lists all of your sites and readers.)  The View menu also
lets you turn the toolbar on or off.  And it lets you get to access profiles,
holidays, activity filters, time zones, and system settings.  (You don't
need these options on an ongoing basis; these are normally only used
when setting the program up.)  See page 18.

Window:  The Window menu lets you switch between open windows, tile
open windows horizontally on the screen, or switch panes within the
network window; see page 20.

Help:  The Help menu lets you pop up the help system you are looking at
now.  (You can also press F1 to pop up help.)  See page 21.
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File Menu The file menu lets you log in and out, generate
reports, archive older activity, import setup
information, and shut the program down.

Login:  You must log in to HandNet before you
can do anything other than look at
information; see page 4.  You must log in
to acknowledge alarms, add sites and
readers, add or change users.  When you
are done using the program, click this
same option again to log out so
unauthorized operators can't use the
program.

Reports:  This brings up another menu that
lists several standard reports, and that
lets you create custom reports based on
the activity that you see in the activity window; see page 13.

Archive:  This takes older information from the current activity file and
stores it in a separate file.  Once you archive information, the activity
is no longer visible in the activity window, but you can still generate
reports based on the archives.

Convert Handnet+:  If you have been using HandNet+ or HandNet (our older
MS-DOS programs) and are just switching to HandNet for Windows,
this converts user information from HandNet+ and adds it to the user
list in HandNet for Windows.  Information imported includes: user
name, user ID number, authority level, and reject threshold.  See
page 98.

Register:  After the first time you use this version of HandNet, you have 14
days to register it.  You must register it even if you registered your
previous version of HandNet.  If you don't register it within 14 days, you
won't be able to log into the program.  The process should only take a
minute.  To register HandNet:

1. If the registration screen isn’t shown, pick Register from the File
menu, and print the registration form.

2. Fill the form out and fax it to the number at the top of the form.
Once we receive your completed form, we'll fax an activation code
back to you within two business days.  (Since this could take two
days for us to send your code back, please print and send the
registration form now; don't wait until day 14.)

3.Pick Register from the File menu, enter the activation code we sent,
and click the Activate button.  Once you do this, HandNet is
permanently functional.

Import TZ:  This lets you change the access profile to Always or Never for
many users based on information in a text file.  See Changing Access for
Many Users at Once on page 95.

Import Users:  If you have readers connected to several different computers
(each with its own copy of HandNet) and if users added to one system
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need to be available on the others, Import Users lets you bring in users
that were added or changed in another copy of HandNet; see page 99.  If
all of your readers are connected to a single copy of HandNet, you don't
need this feature.

Export Activity:  If you want to create custom activity reports using some
external report tool, Export Activity sends all of your current activity to
an access database file called expactvt.mdb; see page 117.  The main
HandNet database files are password protected for security reasons,
but this file is not, so you can open it and access any information in it.
If you're only going to generate reports with Activity Reports on the File
menu, you don't need this option; using it would only create a file that
you don't need.

Exit: This closes the HandNet program, disconnecting it from all readers.
All readers will continue to be able to open doors, but the program won't
receive any information from the readers or process any alarms while
HandNet isn't running.  Unless you are going to install a new version of
the HandNet software or you need to restart the computer that
HandNet is running on, you don't want to Exit the HandNet program.
For security purposes, you would generally Logout so unauthorized
people can't add users or make changes, but you would leave the
HandNet program running all the time.
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Reports Menu To get to the reports menu, click Reports on the
File menu.  This menu lets you create custom
activity reports and print several stock reports.

Activity:  This lets you create reports based on any
activity recorded by HandNet.  This includes
any information in the activity window and
any activity that you have chosen to archive.
You can customize these reports to include
only the information you need.  See Creating
and Printing Custom Activity Views on
page 104.

Users:  This lists all of the users in the system.  The report includes each
user's name, id number, authority level, reject level, and access profile.
It also indicates the last reader used, the last access time, and whether
the user is enrolled.  You can use this report to see if a user is enrolled
and to make sure one user isn't enrolled with multiple id numbers.  If
you have created custom user entries, this report does NOT show any of
them.

Access Profiles:  If you have set up different access profiles to give different
types of users access to different readers or at different times, then this
report can help you see whether you have set your access profiles up the
way you wanted.  This report lists each access profile, sites and readers
the profile gets access to, and the time zone that users can access each
reader.  See page 68 for more about setting up access profiles.

Holidays:  This list all of the holidays you have set up in HandNet.  It lists
the name of each holiday and the month and date.  This report helps you
make sure you have correctly added all holidays for the year.  (If you
have set up any time zones to prevent access on holidays or to give
different access on holidays than on other days, the holidays list
identifies when those holidays are.  If you don't give different access on
holidays than on other days, you don't need to set holidays up or print
this report.)  See page 66 for more about setting up holidays.

Network:  This report tells whether each site is enabled and connection
information (communications port, baud rate, phone number or IP
address, time adjustment, and modem speaker status).  It also lists
readers at the site, whether they are enabled, and their addresses. This
report is used during setup to make sure the network is set up properly.

Time Zones:  This lists all of the different user access period that you have set
up.  (Though we call these access periods "time zones," they have no
connection to the time zones we usually think of that have to do with
different times around the world.)  The report includes the name of each
time zone, the time periods it includes, and the days of the week those
time periods apply.  During setup, this report helps you see if you have
set up all of the necessary time zones and configured them correctly.  (If
you don't need to limit access by day or time (that is, if all users may use
the readers 24 hours a day, 7 days a week if they wanted), then you
don't need time zones.)  See page 62 for more about setting up time
zones.



Menus and Navigation   •   Menu Overviews 14

Site Menu In HandNet, a site refers to a group of up to 32
connected readers.  Put another way, one reader
is physically connected to the computer (by
network, serial cable, or modem), and up to 31
additional readers can be daisy chained to that
first reader; that is, a cable runs from the first
reader to the second, another cable runs from the
second to the third, and so on.  We call this chain
of readers a site.  A site doesn't have any connection to a particular building
or location; these readers could be in one building or in more than one
building (if the buildings are close enough to run a cable from one to the
other), and one building could have one or many sites.

Add Site:  This adds a new site to the HandNet network; see page 34.  You
must set up a site in HandNet before you can set up readers.

Delete:  If you have selected a site in the Network window, Delete removes
the site and all readers assigned to it. HandNet will ask you to confirm
that you want to delete the site.  Make sure that you have selected the
appropriate site since, if you continue, you won't be able to undo the
deletion unless you have made a backup of the files that contain your
site and reader information.  (See page 128 for more about making
backups.)

Rename:  If you have selected a site in the network window, this lets you
rename that site.  (You can also just click once on the site name in the
Network window and rename it there without using this option.)
Renaming a site doesn't change any of its properties and doesn't require
you to set anything up again; it only changes the name that appears in
the lists on the screen and in reports that you generate.  You might
want to rename a site if you discovered that the original name wasn't
clear.

Properties:  This takes you to a window with three tabs that let you look at
or change settings related to how the site is connected to the computer
with the HandNet software.  See Changing a Site on page 34 for further
detail.
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Reader Menu The reader menu lets you add new readers,
delete readers, and rename readers in the
HandNet network.  You can also unlock,
relock, and lockup the selected reader,
enroll a user at the selected reader, activate
and deactivate auxiliary output, and send
(download) time, time zones, users, and
setup configuration to selected readers.

To do anything here except add a reader,
you must select one or more readers first.

Add Reader: This lets you add and configure
a reader to the HandNet Network; see
page 42.  (You must set up a site before
you can add readers in HandNet.)

Unlock:  When you highlight Unlock on the
Reader menu, you see another menu
with two choices:  Indefinite and Timed.  

Indefinite unlocks the door connected to that reader and leaves it
unlocked until you choose Relock on the Reader menu to lock it
again.  (If you regularly want a door unlocked during certain hours,
pick properties from the Reader menu and go to the Configuration
screen.  In the Auto Unlock Time Zone you can indicate when the
door should be automatically unlocked.  The program will
automatically lock the door again at the end of the Time Zone.

Timed unlocks the door connected to that reader and leaves it unlocked
only for the number of seconds specified on the Configuration page
in the Reader Properties.  (That is, it unlocks the door for the same
number of seconds that the door would be unlocked if it were
opened by a reader.)

See Locking and Unlocking Doors on page 130 for more about these
options.

Relock:  If you have unlocked a door with Unlock, Indefinite option, this
locks it again; see page 130.

Lockup:  This disables the lock on the door for the selected reader.  The
reader will still let users enter their ID numbers and still verify hands,
but the door will stay locked even for valid users. The door will stay
locked until you choose Unlock or Relock; see page 130.

Auxiliary Output:  If an auxiliary device is connected to a reader, this lets you
turn that device on or off for the selected reader; see page 131. Auxiliary
output can control local lighting, trigger a third party alarm system,
activate a bell, and so on.

Download:  This lets you send information to the selected readers. While
HandNet automatically sends the appropriate information to readers,
occasionally you will need to use this when correcting a problem with a
reader; see Resending Information to a Reader on page 61.
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Upload (Users):  This lets you get user information from the selected readers.
You would do this if you had been using a reader independent of the
HandNet program and now wanted to add all of the users stored in that
reader to the program.  See Getting User Information from a Reader on
page 99.

Delete:  This removes the selected readers from the HandNet network.

Rename:  This renames the selected reader.  Renaming the reader doesn't
change any of its properties and doesn't require you to set anything up
again; it only changes the name that appears in the lists on the screen
and in reports that you generate.  You might rename a reader if you
discovered that the original name wasn't clear or if you changed the
purpose of the areas the reader gave access to.

Properties:  This takes you to a window with a number of tabs that let you
look at or change a number of settings related to the reader.  See
Changing Reader Settings with Reader Properties on page 45.
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User Menu The User menu lets you add users, delete
users, rename users, change information for a
selected user, and create custom entries to
collect additional information about users.  (If
you've already set up users in a reader that
you are connecting to HandNet, don't recreate
those users; you can Upload Users from the
reader; see Getting User Information from a
Reader on page 99.)

To change, delete, or rename users, select a user first on the list of users.
(For the list of users, pick Users from the View menu, or press CTRL-U.)

Add New:  This lets you add new users; see page 75.  After you add the user,
you must enroll the user (see page 88) before the user will have access
through the readers.

Delete:  This lets you remove a user from the program.  You would do this if
you never wanted that user to be able to use any of the readers in the
HandNet network.  (If you might need the user again but want to keep
the user from using any of the readers, you can also change the user's
access profile to Never.)

Rename:  This lets you rename the selected user.  You would use this if you
entered the user's name incorrectly.  You would also use this if you
added multiple users at once.  (When you use Add multiple new users
to add a number of users automatically, the program uses the ID
number for the name.  You would want to rename these users so you
could identify which ID is for which user.

Properties:  This lets you look at or change information for the selected user;
see Changing Users on page 90.

DB Properties:  This gives you a summary of the total numbers of enrolled
and unenrolled users.  It also lets you add custom entries so you can
collect additional information about users.  For example, depending on
your needs, you might collect emergency phone numbers, birthdays,
employment start dates, or any other information you needed about
your users; see Adding Custom User Entries on page 97.
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View Menu The View menu lets you open the users,
activity, and network windows.  (The
activity window lists both activity and
alarms; the network window lists all of
your sites and readers.)  The View menu
also lets you turn the toolbar on or off.

It also lets you get to access profiles,
holidays, activity filters, time zones, and
system settings.  You don't need these
options on an ongoing basis; they are
normally only used when setting
HandNet up.

Toolbar:  This turns the toolbar off if it is
on and turns it on if it is off.  The
toolbar has icons that help you
quickly get to common options; see
page 7. The toolbar is shown when you start HandNet.  A check is
shown by this option when the toolbar is displayed.

Activity:  This opens the activity window (or brings it to the front if it is
already open and behind other windows).  This lets you see recent
activity and alarms.  If you have created any activity filters to create
lists of specific types of activities, these views are also available here.
The tabs at the bottom of this window let you switch between the
activity list, the alarm list, and any custom views you have created.  See
page 101 for more about the activity window.

Users:  This opens the users window (or brings it to the front if it is already
open and behind other windows).  This window lists everyone who could
potentially gain access through a hand reader.  See page 72 for more
about the users window.  (There is no connection between this list and
the operators authorized to use HandNet; for people who can use
HandNet, see the Operators tab in System Settings on page 24.)

Network: This opens the network window (or brings it to the front if it is
already open and behind other windows).  This window lists all of your
sites and readers.  See page 31 for more about the network window.

Access Profiles:  If some users can only use certain hand readers and/or only
use them at certain times or on certain days, access profiles define when
each type of user can use each reader.  For example, suppose your
maintenance staff should have access to the maintenance rooms seven
days a week, your office staff should have access to the office but only
during business hours, and your supervisors should have access to
everything at any time.  You would create three access profiles:  one for
supervisors, one for office staff, and one for maintenance personnel.
These profiles would identify which readers each group could use.  In
these profiles you would also identify which time periods each group
could use the different readers.  (You would set up these time periods
first using time zones.)  After creating these different profiles,
whenever you added a user, you would just identify which group the
user was a part of, and the access profile for that group would
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automatically give the appropriate access.  See page 68 for more on
setting up access profiles.

To limit access to certain days or times, you must set up time zones
before creating access profiles.

If you want all users to be able to use every reader any time, you don't
need to set up access profiles.  HandNet comes set up with an Always
profile that lets users use any reader in the system 24 hours per day,
seven days per week.  (It also has a Never profile that doesn't let the
user verify at any reader at any time.)

Holidays:  If you have set up any time zones to prevent access on holidays or
to give different access on holidays than on other days, the holidays list
identifies when those holidays are.  If you don't give different access on
holidays than on other days, you don't need to use this option.  See
page 66 for more on setting up holidays.

Time Zones:  If you want some users to be able to use certain readers only
during certain hours or on certain days of the week, time zones let you
identify when access is available.  For example, suppose some users
should only to be able to gain access through certain readers between
8:00 AM and 5:00 PM, Monday through Friday.  You would create a
time zone that identified these times and days, associate that time zone
with appropriate readers using an access profile, and then assign that
access profile to the users.  After you did this, users with that access
profile would only have access during the times you identified in the
time zone.  See page 62 for more on setting up time zones.

If you don't need to limit access by day or time (that is, if users could use
the readers 24 hours a day, 7 days a week if they wanted), then you
don't need to set up time zones.

Activity Filters: This lets you customize the information you see in an activity
window by letting you identify the dates, times, sites, readers, users,
message types, and messages you want to see.  For example, suppose
you want to see who's come in through the main entrance without
having to wade through messages related to activity at other readers.
You could create an activity profile that listed activity only from the
main entrance reader and only if the activity was “Identity verified”
(the message you get when someone enters an ID and the hand is
recognized).  You would then be able to choose this view and see only
this activity.  Activity filters can be much more complex than this; they
can filter or limit an activity list to include any subset of information
you need.  (After you create an activity filter, a tab at the bottom of the
activity window will list the name of the filter; just click that tab for the
corresponding information.)  See Creating a Custom Activity View on
page 104 for more information.

Settings:  This lets you look at or change system-wide settings; see page 22
This includes the name of the system, security, who can use Handnet,
which messages trigger alarms, when old messages should be archived,
and settings for importing and exporting users.
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Window Menu The Window menu lets you switch between open
windows, tile open windows horizontally on the
screen, or switch panes within the network
window.

You will see a check mark to the left of the window
that is currently active.

Switch Panes: If the network window is open,
Switch Panes switches you back and forth
between the list of sites in the left pane of the window, and the list of
readers in the right pane of the window.  This is primarily useful for
users who can't use a mouse; if you can use a mouse, it's easier to just
click the pane you want. If the network window isn't open, this choice
doesn't do anything.

Tile Horizontally:  This adjusts any open windows so they fill the HandNet
window from side to side and so they don't overlap and cover each other
up.  If you aren't sure what tiling is, see the example on page 9.

Activity:  This choice is only here if you have the Activity window open.  This
makes the activity window the active window.  (If the activity window
isn't open, open it by typing CTRL-A or by picking Activity from the View
menu.)  The activity window shows the activity log, error messages, and
any custom activity views you have created.  See page 101 for more
about the activity window.

Network:  This choice is only here if you have the Network window open.
This makes the Network window the active window.  The Network
window lists sites and readers.  (If the Network window isn't open, open
it by typing CTRL-N or by picking Network from the View menu.)  See
page 31 for more about the network window.

Users:  This choice is only here if you have the Users window open.  This
makes the Users window the active window.  (If the Users window isn't
open, open it by typing CTRL-U or by picking Users from the View menu.)
See page 72 for more about the users window.
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Help Menu Instead of going to the Help menu,
you can press F1 from any screen in
HandNet.  This takes you to help for
the screen you are on.  If you need
help on something else, you can use
the Contents, Index, or Search tabs at the left of the window to find what you
need.

Help Topics:  This brings you into the help for HandNet. The help contains
the same information as this manual, but it lets you more easily search
and jump from topic to topic; see page 3.

About HandNet for Windows:  This brings up a screen with copyright
information, the version of the program, the product serial number, and
the name of the person or company the product is licensed to.  (Unless
you need to give your serial number or the program version number to
one our support representatives, or unless you need to check to see if
you are licensed to use all the features of the program, you probably
won't need to come to this screen.)

�����



System Wide Settings

Settings on the View menu lets you control setup issues that are not related
to specific sites or readers.  This includes the name of the system, what user
changes should be allowed at readers, who can use Handnet, which
messages trigger alarms, when old messages should be archived, and
settings for importing and exporting users.

General System Settings
To get to the General tab, pick Settings from the View menu.

Name of
System

Name:  This shows the name that appears above the list of sites in the
Network window.  

Amount of
Activity to

Show

Number of Activity Records to Display:  This shows how many of the most
recent activities to list in the activity window.  HandNet stores
activities even after they are no longer listed in the activity window;
those that are no longer shown are still stored and still included if you
print a report.

Disable All
Sites

Disable All Sites:  Check this box if you need to quickly prevent HandNet
from trying to communicate with any site.  You might check this if you
were servicing a number of sites at once.

�����
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What User Changes Can Come from Readers
To get to the Security  tab, pick Settings from the View menu, and then click
the Security tab.

Whether Users
can be Added
at the Reader

Do not delete unauthorized enrollments:  When this is not checked (HandNet's
initial setting) you can only add new users in HandNet; you can't add a
new user directly at the reader.  (You can add a user at a reader if the
user is in HandNet so you can enroll the user, but if you add a user at
the reader that hasn't been added in HandNet, HandNet will delete the
new user.)  If you want to be able to add and enroll a new user at a
reader without adding the user in HandNet first, check this box.  If you
allow this and if you add a new user from the reader, the user will be
given the access profile selected in the entry below.  (You can change the
access profile on the Security tab in User Properties; see page 92.)

Access profile assigned to unauthorized enrolls:  Indicate what access profile
should be given to a user who is added at a reader.  (If you don't want
the user to be able to access any readers until you change them in
HandNet, choose Never.)

Whether to
Revise the

Stored Images
of Users’

Hands

Update user templates received from readers:  When you enroll a user,
HandNet stores a template that contains information about the shape
of the user's hand.  If this box is checked, then each time a user gains
access, HandNet updates this template.  This means that if the user's
hand changes gradually (for example, if the user gains or loses a
significant amount of weight over time), the image of the user's hand in
HandNet will automatically be gradually adjusted as well.  If there are
gradual changes, checking this prevents users from having access
problems as their hands become increasingly different from the original
image.  If you don't check this, then readers will always compare the
user's hand to the original image created when you enrolled the user.
We recommend having this checked.

�����
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Who Can Use HandNet
The Operators tab lists those
people who are authorized to use
the HandNet program.  When
you click Add or Edit, the
program brings up the Operator
Definition box where you control
which tasks the operator is
allowed to do in HandNet.

To get to this screen, pick
Settings from the View menu,
and then click the Operators tab.

Adding or
Changing an

Operator

You see this box when you add or edit an
operator.  It has the name and password
the operator must use to log into
HandNet.  The boxes that are checked
control which types of activities the
operator can do.

Name:  Enter the name that the operator
will enter on the Login screen.  (See
page 4.)  If the operator is also a user
in HandNet (so he/she can gain access
through readers), the name you enter
here does NOT have be the same as
the name in User Properties.

Password:  Enter the password that the operator will enter on the Login
screen.  Passwords are NOT case sensitive.  For example, if the
password were narnia, Narnia and NARNIA would work identically.

Which Options
the Operator

Can Use

Access Rights:  Check the corresponding boxes to determine which tasks the
operator can do in HandNet.  When you add a new operator, all of the
boxes are unchecked; unless you check them, the operator will be able
to do little more than look at information on the screen.

Click OK to save your changes and return to the list of operators.

Deleting an
Operator

To delete an operator so that person will no longer have access to HandNet,
click the operator in the list and click Delete.  HandNet does NOT ask you
to confirm this deletion, so make sure you have highlighted the right
operator before you click delete.

If the operator is also a user and if you don't want the user to have access to
readers anymore, you must also delete the person from the user list.
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Which Messages Trigger Alarms
The Alarms tab controls which activities generate alarms in HandNet.  To
get to this screen, pick Settings from the View menu, and then click the
Alarms tab.

Messages
Than Cause

Alarms

Messages Which Cause Alarms:  Check each message that should generate an
alarm.  What you check here only determines what triggers an alarm in
the HandNet program; if you are connected to an auxiliary or external
alarm system, actions that trigger external alarms are controlled by the
Auxiliary (AUX) Settings (see page 49) and Extended Setup (see
page 52) tabs in Reader Properties.

Alarms
Sounds

Enable Alarm Sounds:  If this checked, then when an alarm situation occurs,
a loud, siren like alarm sound will begin and continue until you
acknowledge the alarm.  If this isn't checked, when an alarm situation
occurs, you will see a red flashing message at the bottom of the screen
but won't hear any sound.

�����
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When Past Activity Gets Archived
What

Archiving Is
Archiving is moving past activity from the current activity file to a separate
file.  This keeps the activity file smaller and faster while still keeping the
information available for reports if needed.  The Archive tab controls when
HandNet reminds you to archive past activity, where it will make the
archive file if you don't choose another location, and the minimum amount
of activity to keep available in the current activity file.

You can make an archive at any time use Archive on the File menu; see
page 115.

To get to the Archives tab, pick Settings from the View menu, and then click
the Archives tab.

When HandNet
Reminds You
to Make and

Archive

Archive Notification Occurs:  This controls when HandNet reminds you to
make an archive.

When archive file size is bigger than... reminds you only when there is
enough activity for the archive file to reach the size you enter.  How
long it will take depends on the amount of activity.

After ___ days... reminds you make an archive on a regular basis
regardless of the amount of activity during that period.  For
example, if you wanted to make an archive once a year, you could
select this option and enter 365 for the number of days.

On day ___of each month reminds you make an archive once a month.
If you want to include all activity from a particular month in the
archive, and you also want to keep a number of days worth of recent
activity available in the activity window, then you might want to do
this later than the first of the month and change the To date to the
last day of the previous month when you make the archive.  For
example, if you wanted to keep activity from the past week in the
current activity, then you might not make your monthly archive
until the 8th of the month.  That way, when you had made your
archive through the end of the previous month, the past week
would still be in the current activity.
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Default Archive Directory:  This shows the drive and directory (folder) that is
automatically filled in for the file location when you make the archive.
This is initially set to the same folder that the HandNet program is in,
but you can change this if you wish.

What NOT to
Archive

Do Not Archive the Latest __ Events:  This indicates how many events or
activities to keep in the current activity file.  You can choose from 1-500.
When you make an archive, HandNet this number of the most recent
events in the activity file.  If you want to keep more events than this in
the current activity file, you can do this when you make the archive by
changing the To date.  For example, if you always wanted to keep at
least the activity for the past week, when you make the archive, you
could set the To date a week in the past.

Exporting
Activity When

Archiving

Export Transactions:  If you check this, then whenever you make an archive,
HandNet exports all the transactions being archived to an access
database file called expactvt.mdb.  (You can also export transactions
with Export Activity on the File menu; see page 117.)  While the main
HandNet database files are password protected for security reasons,
this file is not.  This lets you create custom activity reports using the
activity from HandNet using external report generating tools.  If you're
only going to generate reports with Activity Reports on the File menu,
you don't need to check this box; doing so would only create a file that
you don't need.
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When Users Get Imported and Exported
User Import/

Export Tab
The User Import/Export tab is only available if you have purchased the
upgrade to the full feature set of version 2.0.

This tab controls what user information is imported and exported, and
whether imports are automatic or manual.  You only need this tab if you
have readers connected to several different computers (each with its own
copy of HandNet) and if users added to one system to be available on the
others.  If all of your readers are connected to a single copy of HandNet, you
don't need this feature.

To get to this screen, pick Settings from the View menu, and then click the
User Import/Export tab.

Setting Up for
Common

Situations

If all of your readers are connected to a single copy of HandNet:  You don't need
this feature.  Click the Typically Disabled Settings button to make sure
that the import and export features are both turned off.

If you have HandNet running on several computers and you want to be able to add,
change or delete users from any of those computers:  Click the Typically
Enabled Settings button to turn both the import and export features on.

If you have multiple computers with HandNet but you only want users added,
changed, deleted, or enrolled on this computer:  Check the Enroll, Update,
and Delete boxes in the Export column, and uncheck all of the boxes in
the Import side of the screen.  This causes HandNet to export users but
prevents changes from elsewhere from being imported.

If you have multiple computers with HandNet but you only want users added,
changed, deleted, or enrolled on another computer:  Check the Create,
Modify, Delete and Enroll boxes in the Import column, and uncheck all
of the boxes in the Export side of the screen.  (You can also enable Auto
Import if you wish.)  This keeps HandNet from creating an export file
that you don't need, and enables it to import changes from another
computer.
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Import
Settings

Types:  This controls what user information HandNet will import.  Make
sure that you select the correct choices here before you try to import.
When HandNet imports, it empties the import file, discarding those
user records that don't meet the conditions you have checked here.

Create:  If this box is checked and HandNet finds a new user in the
import file, HandNet adds that user to your database.  If this
box isn't checked, HandNet won't import any new users.

Modify:  If this box is checked and HandNet finds a user in the
import file with the same ID number as a user that you already
have, HandNet replaces the information for the user you have
with the user in the import file.  If this box isn't checked and
HandNet finds a user in the import file with the same ID
number as a user that you already have, HandNet won't
change the user that you have.  If you don't have this checked,
you could end up with different information for a user on
different computers.

Delete:  If this box is checked and HandNet finds a user marked for
deletion in the import file, HandNet deletes that user from
your computer as well.  If you don't have this checked, you
could end up users that are still on your computer that are not
in the copies of HandNet running on the other computers.

Enroll:  If this box is checked and HandNet finds a newly enrolled
user in the import file, HandNet imports the user and the
template (image of the user's hand).  If you don't check this,
you will have to enroll new users on each computer where they
are imported.

Empty Templates:  If HandNet finds a user that isn't enrolled in the import
file, and it finds a user with the same ID number that is enrolled, this
entry controls what HandNet will do.  Ignore if enrolled keeps the
enrolled version of the user that you already have rather than replacing
the user with the unenrolled user.  Allow overwrite replaces the
enrolled user with the unenrolled one; this means that the user will
have to be enrolled again.  (To avoid this, on the computer that is
exporting the users, don't check Add New on the Export side and make
sure Empty Templates on the Export side is set to Skip.  This way, users
won't be exported until they are enrolled.)

Auto Import:
Enable:  If you check the Enable box, HandNet automatically

import users whenever it finds an import.mdb file in the
HandNet directory.  If this box isn't checked, then HandNet
only import users when you pick Import Users from the File
menu; see page 99.

Show Notification:  If you check this box and the Enable box above is
also checked, then when HandNet automatically imports
users, it shows a message on the screen that lets you know that
users are being imported.  If you don't check this box, then
HandNet just imports the users without popping a message
up.  (Either way, HandNet also records the activity in the
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activity window.)  If the Enable box isn't checked above, this
entry doesn't apply.

Export
Settings

Types:  This controls what user information HandNet exports.
Add New:  If this box is checked and you add a user, HandNet

exports the user.  Normally you don't want this box checked;
you usually want HandNet to wait until the user is enrolled
before exporting the user.  If you have this checked, HandNet
exports the unenrolled user.

Enroll:  If this box is checked, then HandNet exports a new user
after the user is enrolled.

Update:  If this box is checked and change information for a user,
HandNet exports the changed information.  This can help keep
user information the same on all of the computers.

Delete:  If this box is checked and you delete a user, HandNet
exports the fact that the user was deleted.  If the other copies
of HandNet are set up to import deletions, then the user will be
removed from those computers as well.

Empty Templates:  If you add or change a user that hasn't been enrolled yet,
this controls whether or not HandNet will export it.  Normally you only
want HandNet to export users after they are enrolled, so you would
leave this set to Skip.

“Typical”
Settings

These buttons automatically check the appropriate options for two
situations:

Typically Enabled Settings:  This checks the appropriate boxes for a computer
to be able to automatically import and export users.

Typically Disabled Settings:  This unchecks all of the boxes; this is appropriate
for any user who isn't running HandNet on more than one computer.

See Setting Up for Common Situations on page 28 for more on common
setups.

Getting
Exported
Users  to
Another

Computer

See Importing Users from Another Copy of HandNet on page 99 for more on
how to get the exported user information to the other computer so you can
import them there.
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Setting Up Sites and Readers

Seeing Sites and Readers in the Network Window 
The Network window lists every site and reader that you have added in
HandNet.  To open this window, pick Network from the View menu or press
CTRL-N.

The left pane lists all of your sites (that is groups of connected readers).  The
right pane lists all of the readers in the currently selected site.  (To list all
readers for all sites, click HandNet System at the top of the left pane.)

Understanding
the Icons to

the Left of the
Name

You see one of these icons to the left of each reader’s name:

Changing How
the Readers
are  Sorted

You can sort the list of readers using the information in any column by
clicking on the column heading.  For example, to sort the list alphabetically
by name, click on the name heading.  If you click on the same heading again,
it will sort the list in reverse order.  (For example, using the name, it would
sort from Z to A.)  You can also sort by address (this might be useful if you
wanted to find the next available number for a new reader), by status (this
could be useful to group all of the readers that are not enabled or that are
having communication problems), or by site if you clicked HandNet System
at the top of the site list to list all readers from all sites at once.

Rearranging or
Resizing the

Columns

To move any column, click the column heading and hold the mouse down.
With the mouse held down, drag the column heading to the left or right.
(See the User’s window in the on-line help for an example of this.)

You can also change the width of a column by pointing to the edge of the
column heading, holding the mouse down, and then dragging the edge of the

The green light indicates that this reader is currently connected and
communicating with HandNet.

The black dot indicates that HandNet communicates with this reader by
modem, and HandNet isn't currently connected with the reader.  (When
HandNet connects with the readers in that site depends on what you have
on the Schedule tab in the Site Properties.

The empty circle indicates that you haven't enabled this reader.  This is
the case when you are setting a new reader up.  (You enable a reader on
the General tab in Reader Properties.  You must also enable the site on the
General tab in the Site Properties.)

The red light indicates that there is a communication problem between
HandNet and the reader.  The reader may not be configured correctly, or
there may be a problem with the way the reader is connected.
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column to the desired position.  This lets you fit more columns in the
window.

F5 restores all columns to the widths they had when you started HandNet.
If you want HandNet to save the new column widths, exit the HandNet
program and come back in.  HandNet then uses your changed column
widths as the new standard or default.

�����
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Setting Up Sites, Overview

What a Site Is In HandNet, a site refers to a group of up to 32 connected readers.  Put
another way, one reader is physically connected to the computer (by
network, serial cable, or modem), and up to 31 additional readers can be
daisy chained to that first reader; that is, a cable runs from the first reader
to the second, another cable runs from the second to the third, and so on.  We
call this chain of readers a site.  A site doesn't have any connection to a
particular building or location; these readers could be in one building or in
more than one building (if the buildings are close enough to run a cable from
one to the other), and one building could have one or many sites.

You control access to each reader separately, so having readers with
unrelated purposes in one site is fine; the site designation merely indicates
that the readers are physically connected to each other.

There are two parts to setting up a site and readers:  you must physically set
the readers up and connect them to each other and to the computer, and you
must add the site and readers in HandNet.  This help only explains adding
the site in HandNet.  For help setting up and connecting the readers, see the
manual that came with the readers.

Before You
Enable a Site

If you have been using readers without HandNet and you want to get the
users from the reader(s), follow these steps BEFORE enabling the site and
reader:

1. Pick Settings from the View menu.
2. Click the Security tab.
3. Check the box by Do not delete unauthorized enrollments.  (See page 23

for more about what this option does.  After you have gotten your users
from the reader, you may want to check this box again.)

If you enable both the site and the reader without changing this setting,
HandNet regards all of the users in the reader as unauthorized (because
they aren't in HandNet yet) and deletes them from the reader.  Once it
deletes them, there is no way to get them back without adding and enrolling
the users again.

�����



Setting Up Sites and Readers   •   Adding or Changing a Site 34

Adding or Changing a Site

Adding a Site Click Site on the main menu bar at the top of the screen, and then pick Add
Site.  This starts the New Site Wizard.

Changing a
Site

Click a site in the left pane of the Network window, pick Properties from the
Site menu, and then click the tab with the information you need to change.

Name This is the first screen in the process of adding a new site.  Enter a name
that identifies the site, and then click the Next button.

Type of
Connection

When adding a new site, this screen lets you indicate how HandNet will
communicate with the site.
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Adding a Site in HandNet

1. Click Site on the main menu bar at the top of the screen, and then pick
Add Site.  This starts the New Site Wizard.

2. Complete each screen and then click the Next button at the bottom of
the screen.  The screens that you see in this process vary depending on
whether the site is connected to the computer by a serial cable, through
a network, or by a modem.

3. On the final screen, indicate whether to enable the site.
If the site is physically set up and connected:  Enable the site now.  Check

the Enable Site box and then click Finish.
If the site isn't physically set up yet:  Enable the site later.  To do this, you

will open the network window, double-click the site in the left pane
of the window to open up the site properties, check the Enabled
box, and then click OK.
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Serial Port:  To connect to a site by running a cable from your computer to the
reader, you must have a free serial port on your computer.  See the
HandKey manual for more on the requirements for the cable.  This first
reader must have an address of 0 (and no other reader in the site can
have an address of 0).

Modem:  To connect to a site by modem, the first reader in the site must have
a modem installed in it.  (Contact your dealer for more information.)
This first reader must have an address of 0 (and no other reader in the
site can have an address of 0).

IP Network:  To connect to a site through your network, you must have a TCP/
IP network with static IP addresses.  Your computer must have a
network card and be connected to the network.  If the network is faster
than 10baseT, you must have a switching hub.  The first reader in the
site must have an ethernet card.  (Contact your dealer for more
information.)  This first reader will automatically have an address of 0
(no other reader in the site can have an address of 0), and you must
enter a unique IP address in the reader.  See Configuring the Physical
Reader on page 55 for more detail on this. 

Serial Port
Connection

To connect to a site by running a cable from your computer to the reader, you
must have a free serial port on your computer.  See the HandKey manual for
more on the requirements for the cable.  This first reader must have an
address of 0 (and no other reader in the site can have an address of 0).

Serial Port: Click this and pick the serial port that the cable from the reader
is connected to.  If you pick the wrong port here, HandNet won't be able
to communicate with the reader.  If you have several sites, each must be
connected to a different serial port.  HandNet only lists ports set up on
your computer that are not already used for communicating with
another site.  If you click this and get a blank list, all of the serial ports
are already used.  Contact the person who services your computer
hardware if you need to add additional serial ports.

Baud Rate:  Click this and pick the baud rate.  We recommend 9600.  While
19200 should theoretically be faster, because of the way the reader
sends information, this doesn't result in any real gain.  The speed here
must match the speed set in the reader; see Configuring the Physical
Reader on page 55 for more detail on how to change the baud rate in the
reader.

when adding a new site when changing a site
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Modem
Connection

To connect to a site by modem, the first reader in the site must have a
modem installed in it.  (Contact your dealer for more information.)  This
first reader must have an address of 0 (and no other reader in the site can
have an address of 0).

Serial Port:  If you have an external modem, click this and pick the serial port
your modem is connected to; this is usually (but not always) COM1 or
COM2.  If you have an internal modem, it is usually connected to COM3
or COM4.  HandNet only lists ports that are set up on your computer
and that are not already used for communicating with another site.

Baud Rate:  Choose 9600 if you are connecting to a HandKey II or HandKey
CR; choose 2400 if connecting to a HandKey.

Modem Init String:  If you need HandNet to send any commands to the modem
before dialing, enter the appropriate codes here.  The modem must be
set up for no data compression, no error correction, an appropriate baud
rate, and auto answer.  The manual that came with your modem
explains the various commands that work with your modem.  An
inappropriate init string can prevent the modem from connecting.  Try
connecting without any init string to see if you can communicate; you
modem may be automatically set up correctly.  If you have problems
getting your modem to connect and communicate with the site, here are
init strings that have worked for some modems:

Typical modem strings AT&F&C1&D2X1V1E0 
AT&C1&D2X1V1E0 
AT&C1X1VE0

Rockwell Chip Set Modems AT&D2E0&Q0N0S37=5

US Robotics Sportster 14.4 F/M AT&F0
AT&FX0&C1&D2&H0&N6&K0S0=0

Everex 2400E AT&F

Hayes Accura 14,400 1200
Baud 

AT&F&C1&D2&K0S0=0S37=5

2400
Baud

AT&F&C1&D2&K0S0=0S37=6

Hayes Optima 14,400 1200
Baud

AT&F&C1&D2&K0S0=0S37=5

2400
Baud

AT&F&C1&D2&K0S0=0S37=6

when adding a new site when changing a site
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Phone Number:  If you have to dial some digit to get an outside line, enter this
digit followed by a comma before the phone number.  If the number is
a long distance number, enter the 1 and the area code as appropriate.
For example, if you had to dial a 9 for an outside line, and the number
was long distance and required 1 and an area code, you would enter the
number like this: 

9, 1-802-555-1212

You don't have to enter the dashes; they don't make a difference.  You
could equally well enter the number above like this:

9, 18025551212

Time Adjustment:  If this site is in a different time zone, enter the number of
hours the time difference is.  For example, if you were in New York and
were setting up a connection with a site in California, you would enter
-3 since in California it is three hours earlier than in New York.  If you
were in California and setting up a connection with a site in New York,
you would enter 3 since it is three hours later in New York.  Only do this
if you want all times reflecting the time zone you are currently in.

Modem Speaker On During Dial:  If you check this box, when HandNet
connects to this site, it turns the modem speaker on so you can hear it
dialing and connecting.  If there is a problem connecting, turning the
modem speaker on can help identify where the problem is.  Unless you
are having a problem connecting, we don't recommend checking this
box.

Practical Peripherals
PM144MTII 

1200
Baud

AT&F&C1&D2&K0S0=0S37=5

2400
Baud

AT&F&C1&D2&K0S0=0S37=6

Practical Peripherals
14.4 FXSA

1200
Baud

AT&D2E0&Q0N0S37=5

2400
Baud

AT&D2E0&Q0N0S37=6

Cardinal 33.6 V.34/
V.FC

1200
Baud

ATE0S37=5&C1&D2&K0

2400
Baud

ATE0S37=6&C1&D2&K0

Multitech  Model MT1932ZPX AT&F&C1&D2X1V1E0&E0&E3&E7&E8
&E10&E12&E14$MB1200$SB1200

Zoom Model cc4336 2400
Baud

AT&Q0&K0+MS=2
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Scheduling a
Connection

Time

If you are connecting to sites by
modem, this screen shows when
HandNet is scheduled to connect with
each site.  You can only change the
connection time for the current site.
(This screen doesn’t apply if you
aren't communicating by modem; if
you connect by serial port or through
a network, HandNet stays connected
to the site continuously and doesn't
need a scheduled connection time.)

Adding a New
Scheduled

Connection
Time

When you choose to add a new schedule time, you
see this screen.

Enable this schedule item:  This box must be checked
for HandNet to make the connection.  Only
uncheck this box if the modem is not set up yet
at the site and you don’t want HandNet to try to
communicate with the site.

Connect Time:  Enter the time that you want
HandNet to try to connect.  This must be at least one minute later than
the disconnect time for the previous connection.  For example, if
another connection is scheduled to end at 5:00, the new connection can
be scheduled for 5:01, but not for 5:00.  If the phone lines are busy when
HandNet tries to connect, it will keep trying until it makes a connection
(or reaches the Disconnect Time).

Disconnect Time:  If you uncheck this box, HandNet will stay connected to
this site continuously.  Since the modem will be continuously connected
to that site, you won't be able to schedule a connection to any other site;
if you need more than one connection, this must be checked.  When you
enter a disconnect time, it must be after the start time.  For example,
you can't schedule a connection to both begin and end at 5:00; if the
connection begins at 5:00, the disconnect time must be 5:01 or later.

When you enter the disconnect time, allow enough time for HandNet to
download all of the potential activity in the reader.  The reader can send
about 100 events a minute.  This means that if the reader were full
(with 5000 events), it could take up to an hour to get all of the activity.
The amount of activity you have each day and the number of times you
connect to reader during the day determine how long your connection
must be.

When HandNet reaches the disconnect time, it disconnects even if there
is still activity that the reader needs to send.  When HandNet
disconnects, if the reader weren’t done sending activity, a few activities
would be lost.  If there is regularly more activity at the reader than the
connection time allows for, the reader’s memory would eventually fill
up; at which point additional activity would also cause activity to be
lost.  To avoid this, make sure the time between the Connect Time and
the Disconnect Time is long enough to get all of the activity.
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Changing or
Deleting a
Scheduled

Communication
Time

Even though HandNet lets you see the scheduled connection times for all
sites, HandNet only lets you change a scheduled time for the site you are
currently working with.  To change a scheduled time for a different site, you
must go to the properties for that site, select the scheduled time there, and
then click the Edit button.

If You Get a
Message that

the Time
Conflicts

If the time that you enter conflicts with the time that HandNet is already
scheduled to communicate with a different site, you see a message like this:

Make sure that each other scheduled connection has a disconnect time.  If
you scheduled a connection with no end time, HandNet would never
disconnect from that site, so it wouldn't be possible to schedule another
connection.  If you want to have more than one scheduled connection, each
connection must have a disconnect time.

Also make sure the connect time is at least one minute later than the
disconnect time for the previous connection.  For example, if another
connection is scheduled to end at 5:00, the new connection can be scheduled
for 5:01, but not for 5:00.

IP Address You see this screen if you indicate that HandNet will communicate with this
site through a network.

IP Address:  Each site must have a unique IP address.  Ask your network
administrator for an appropriate address.  The address you enter here
must match the address you enter in the reader; see Configuring the
Physical Reader on page 55 for more on how to change the address in
the reader.

Port:  This entry no longer applies.  It is always grayed out.

when adding a new site when changing a site
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Enabling the
Site

This is the final screen that you see in the New Site Wizard.  (When you go
back to Site Properties to change this site, this is on the General tab.)

Enable Site:  You must enable the site before HandNet can communicate
with the readers in it, but you might not want to enable it yet.  Please
read the sections below if you aren't sure.

If the site isn't
physically set

up yet

If the site isn't physically set up yet, don't enable it; you don't want HandNet
to repeatedly try to communicate with something that isn't there.  This
would slow the system down.

If you've been
using readers
independently

of HandNet
and you need

to get users
from the
readers

If you have been using readers independently of HandNet and if you want
to get the users from the readers into HandNet, you also do NOT want to
enable the site until you have set HandNet to accept users from the
reader that aren't in HandNet.  To do this:

1. Click Finish without checking the Enable Site box.
2. Pick Settings from the View menu.
3. Click the Security tab.
4. Check the box by Do not delete unauthorized enrollments.    (See page 23

for more about what this option does.  After you have gotten users from
the reader, you may want to check this box again.)

If you enable both the site and the reader without changing this setting,
HandNet will regard all of the users in the reader as unauthorized (because
they aren't in HandNet yet) and it will delete them from the reader.  Once
it deletes them, there is no way to get them back without adding and
enrolling the users again.

If you’re
ready to
connect

If the site is physically set up and you don't need to get users from the
readers (or if you've already changed the setting above), then you can enable
the site now.  Check the Enable Site box and then click Finish.

To Enable the
Site Later

After you leave this screen, you can enable the site by doing this:

1. Open the Network window.
2. Double-click the site in the left pane of the window to open up the site

properties.  (Or click once and pick Properties from the Site menu.)
3. Check the Enabled box and then click OK.

�����
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Setting Up Readers, Overview
There are two parts to setting up readers:  physically setting the readers up
and connecting them to each other and to the computer, and adding the site
and readers in HandNet.  This manual only explains adding the site and
readers in HandNet.  For help setting up and wiring readers, see the
manual that came with the readers.

Before you add readers, you must set up the site they are connected to; see
page 34.

Before You
Enable the

Reader

If you have been using readers without HandNet and you want to get users
from the reader(s), follow these steps BEFORE enabling the site and reader:

1. Pick Settings from the View menu.
2. Click the Security tab.
3. Check the box by Do not delete unauthorized enrollments.  (See page 23

for more about what this option does.  After you have gotten your users
from the reader, you may want to check this box again.)

If you enable the site and the reader without changing this setting,
HandNet regards all users in the reader as unauthorized (because they
aren't in HandNet yet) and deletes them.  Once it deletes them, there is no
way to get them back without adding and enrolling the users again.

Selecting
Readers

Most options on the Reader menu are disabled until you select a reader.

To select a single reader:  Click that reader in the list.

To select multiple readers that are together on the list:  Click the first reader in
the group, hold the SHIFT key down, and with the SHIFT key down, click
the last reader that you want to select.

To select multiple readers that are not together on the list:  Click the first reader
to select, hold the CTRL key down, and with the CTRL key down, click
each other reader that you want to select.

Renaming a
Reader

You might rename a reader if you discovered that the original name wasn't
clear or if you changed the purpose of the areas the reader gave access to.
Renaming the reader doesn't change any of its properties and doesn't
require you to set anything up again; it only changes the name that appears
in the lists on the screen and in reports that you generate.

To rename a reader:

1. If the Network window isn't open, pick Network from the View menu
(or press CTRL-N).

2. Click the reader in the right pane of the Network window.
3. Pick Rename from the Reader menu.  (You could also right click and

pick Rename, or you could double-click the reader and change the name
in the Reader Properties.)
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Setting up a New Reader

Getting Started When you pick Add New... from the Reader menu, HandNet starts the New
Reader Wizard.  This takes you through the process of adding the reader.

Name and
Address

Screen

This is the first screen that you see when adding a new reader:

Enter the reader's name:  Enter any name that clearly describes the reader's
function and location.  This name is used in the Activity window and in
activity reports to identify where activity took place.

Choose the site where the new reader is located:  Click this to pick the site
(group of readers) that this reader is connected to.  You must set the site
up before you can add the reader.

This reader is physically configured for address:  HandNet automatically fills
in the first available address that hasn't been used yet in this site.  For
example, if you already have readers 0, 1, and 2 in this site, HandNet

4

8

,

&

.

6

7

(

3

6

Adding a New Reader

1. Click Reader on the main menu bar at the top of the screen, and then
pick Add New.  This starts the New Reader Wizard.

2. On the second screen of the New Reader Wizard, indicate whether you
want to set the reader up by going through each configuration screen, or
whether you want to copy the settings from another reader.  Copy the
settings from another reader if the settings are identical or even similar
to the other reader.  (If you copy settings, you can use Properties on the
Reader menu to make changes.)

3. If you are setting up the reader by going through each configuration
screen, see the different tabs in the Reader Properties for help with
particular entries.  Click the Next button at the bottom of the screen to
continue with the next screen.

4. Make sure that the address in the reader matches the address you
entered on the first reader properties screen.  See Configuring the
Reader for more details.

5. Once the reader is physically connected and set up correctly, enable the
reader.  To do this, open the network window, double-click the site in
the right pane of the window to open the Reader Properties, check the
Enabled box, and then click OK.
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automatically fills in an address of 3.  You can change this if you wish.
The first reader in each site must be reader 0; other readers in the site
can use any number up to 254.  Readers do not need to be numbered
sequentially.  For example, your readers could be numbered 0, 1, 2, 3...
or they could be numbered 0, 100, 110, 137....  Within a site, each reader
must have a unique number.  For example, you can't have two readers
in the same site that both use the address of 1.  However, you can reuse
numbers in different sites.  For example, if you had 20 sites, you could
have a reader with an address of 1 in each of them.

Make sure
the address
matches the

address in the
reader

The number here must match the address entered in the reader.  See
Configuring the Physical Reader on page 55 for more on how to set the
address up in the reader.

Never put
more than 32

readers in a
site

Even though HandNet allows numbers from 0 to 254, you should never have
more than 32 readers in a site.  While it is sometimes technically possible to
connect more than 32 readers, not all readers support this, and even for
readers that do, connecting more than this causes unacceptably slow
response times from readers.  The software was not design to handle more
than this, and we can't guarantee results with more than 32 readers.  If you
feel that more than 32 readers in a single site is essential for you, please
contact us to discuss your situation first; in nearly all cases, the preferable
(and sometimes only) solution is to set up additional site(s).

Click Next to go on to the next screen.  This button is disabled until you have
filled in all of the entries on this screen.

Configuration This is the second screen that you see in the process of adding a new reader.
This screen lets you choose whether you want to set the reader up by going
through each configuration screen in the reader properties, or whether you
want to copy the settings from another reader.  Copy the settings from
another reader if the settings are identical or even similar to the other
reader.  If you copy the settings from another reader, and you want to make
the settings slightly different, you can use Properties on the Reader menu to
make changes; see page 45.

Configure the new reader:  This lets you go through each of the reader
properties screens so you can choose the appropriate settings on each.
The Reader Properties screens are explained starting on page 45.  You
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would choose this for the first reader you add.  You would also choose
this if you wanted very different settings from the other readers.  For
example, if other readers were set to trigger an auxiliary alarm after
certain events and you didn't want this reader to trigger an alarm, or if
other readers had an automatic unlock time and you didn't want that
for this reader, then you might want to use this option.

Copy the configuration from another reader:  If another reader has the same or
nearly the same settings as you want for this reader, copying settings
from the other reader is faster.  It also protects you from accidentally
making the settings slightly different if you want readers configured
exactly the same way.

If you choose this option, click the reader in the list to copy the settings
from and then click the Finish button.  (The Next button changes to a
Finish button when you choose this option.)

When you copy the configuration from another reader, HandNet does
NOT enable the reader.  You must go to the General tab in the Reader
Properties to enable the reader before HandNet will communicate with
it; see page 45.

If you copy the settings from another reader, and you want to make the
settings slightly different, you can use Properties on the Reader menu
to make changes; see page 45.

�����
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Changing Reader Settings with Reader Properties

Getting  to the
Reader

Settings

Click a reader in the right pane of the Network window, and pick Properties
from the Reader menu.  (Or just double-click the reader in the Network
window.)  You are initially on the General tab; click any other tab to jump
to the corresponding screen.

General This screen contains the reader's
name and address, the site the reader
is a part of, and whether or not the
reader is currently enabled and
connected.

Name:  The name is to help you
identify the reader.  Changing
the name doesn't affect any of the
reader's other settings or
connection.  If you change the
name of the reader, the new
name is used in activity reports
for activity at that reader, even if
the activity occurred before the
name change.  

Site:  This is the site (that is, the group of up to 32 readers) that this reader
is associated with.  

Address:  The number here can be from 0 to 254.  If the site is connected by
IP Network, the first reader in the site (the one with the ethernet card)
must be reader 0.  Other readers can use any number and don’t need to
be numbered sequentially.  For example, your readers could be
numbered 0, 1, 2, 3... or they could be numbered 0, 100, 110, 137...  You
can use the same reader number in more than one site.  For example, if
you had 20 sites, you could have a reader 1 in each of them.

The number here must match the address entered in the reader.  See
Configuring the Physical Reader on page 55 for more on how to set the
address up in the reader.

Even though HandNet allows numbers from 0 to 254, you should never
have more than 32 readers in a site.  While it is sometimes technically
possible to connect more than 32 readers, not all readers support this,
and even for readers that do, connecting more than this causes
unacceptably slow response times from readers.  The software was not
design to handle more than this, and we can't guarantee results with
more than 32 readers.  If you feel that more than 32 readers in a single
site is essential for you, please contact us to discuss your situation first;
in nearly all cases, the preferable (and sometimes only) solution is to set
up additional site(s).

Enabled:  This should be checked once reader setup is done and users should
have access through the reader.  Leave this unchecked if you don't want
HandNet to try to communicate with the reader at this point.
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If you have been using readers without HandNet and you want to get
the users from the reader, follow these steps BEFORE enabling the site
and reader:

1. Pick Settings from the View menu.
2. Click the Security tab.
3. Check the box by Do not delete unauthorized enrollments.  (See

page 23 for more about what this option does.  After you have
gotten your users from the reader, you may want to check this
box again.)

If you enable both the site and the reader without changing this setting,
HandNet will regard all of the users in the reader as unauthorized
(because they aren't in HandNet yet) and it will delete them from the
reader.  Once it deletes them, there is no way to get them back without
adding and enrolling the users again.

Status:  This indicates whether the reader is connected.

Settings This screen controls the reader's
display and other factors that affect
what happens when the user enters
an ID number at the reader.

12 Hour Display:  If you check this, the
reader displays times after noon
using the numbers 1-12; if it isn't
checked, it uses 24 hour time.
For example, if this is checked
5:00 PM displays on the reader as
5:00; if this isn't checked, 5:00 PM
displays as 17:00.

Display System Status:  Don't check
this option unless asked to by one of our support staff.  This displays
technical information on the reader display about the status of different
aspects of the reader.  It isn't relevant to normal use of the reader.

Beeper On:  If this is checked, the reader beeps each time you press a button
on it; if this isn't checked, the reader doesn't beep.  In a high security
setting, you might want the beeps off to make it harder for a casual
observer to figure out how many digits are in the ID number.  In other
contexts, your choice here depends only on your preference; some people
like the beeps since it lets them know that they haven't missed the
button; others prefer not to hear them.

Time and Attendance Mode:  Do not check this option.  If you check this, the
reader asks users for additional information related to time and
attendance tracking (whether one is coming in or out or leaving for a
job, the job number you are working on, etc.).  However, HandNet is
currently NOT able to store or track this information.

Emulate Card Reader:  If you want the reader to send output directly to a lock
and unlock it, leave this unchecked.  If you have an access control panel
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and want the reader to send information formatted like card output to
that control panel, check this box.

Facility Code:  This only applies if you are emulating a card reader.

ID Length:  If all of your user IDs are the same length, you can enter the
number of digits here so that users don't have to press ENTER or YES
after typing the ID at the reader.  For example, if all of your IDs are four
digits long, then you could enter 4 here.  Then, at the reader, once the
user had entered four digits, the reader would ask the user to place the
hand (assuming the ID was valid).  Without this, the user would have
to type the four digits and then press the ENTER or YES button on the
reader.  However, if you use a duress code (see below), don't enter a
number here.  This is because the duress code adds a digit; if your IDs
are four digits, the user will have to be able to enter five digits if they
ever need the duress code.  If you are using a duress code, leave this set
to 10.

Number of Tries:  If a user enters a valid ID number but the users hand does
not match the image stored, the reader does not give access.  This entry
controls how many times the user can try to get access before the reader
will block the user's ID and not allow further tries.  This prevents
someone from making repeated tries to gain access with someone else's
ID number.  Normally 3 is a good setting here; it allows for two retries
if the user didn't place the hand correctly, but limits the number of
attempts someone can make.

If the user doesn't gain access after the number of tries here, the reader
no longer accepts that user's ID until another user successfully gains
access through that reader.

Duress Code:  A duress code is single digit that users can enter before the ID
number to indicate that they are in danger or that someone else is
forcing them to open the door. For example, suppose that you set “0” up
as a duress code.  If a user were being forced to let someone into the
building, instead of entering the regular ID of 1234, the user would
enter 01234.  The system would still grant access as it would for the
normal ID, but it would also trigger an alarm.  This could be merely the
alarm in the HandNet program, or, it could also trigger an external
alarm through the Auxiliary Settings; see page 49.

0 (zero) is often a good digit for the duress code because you can’t begin
a user ID with zero if you enroll users from the command menus on the
reader.  (While HandNet distinguishes between 5 and 0005, the process
of adding a user from the reader command menu doesn’t.  This means
that if you created a user with an ID of 0005 in HandNet and tried to
enroll that user with the command menus on the reader, when you
typed 0005, the reader would think you were enrolling user 5.  This
wouldn’t correspond with 0005 in HandNet.)
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Configuration This screen controls how closely the
typical user’s hand must match the
image that is stored, how long the
door can stay open, and when (if ever)
the door should be automatically
unlocked.

Reject threshold:  The lower this
number is, the more closely the
user's hand must match the
image or template of the hand
stored in HandNet.  30 (the
lowest possible number) requires
the hand shape and position to
match very closely; 250 (the highest possible number) will grant access
if the hand match is close but not exactly the same.  100 is good for most
contexts; enter a lower number if you have an especially high security
situation.  You can either enter a number or drag the pointer.

If particular users have trouble placing their hands consistently
because of arthritis or some other hand condition, you can override the
reader's setting for an individual user on the Security tab in the User
Properties; see page 93.

Lock Open For:  This is the number of seconds the door stays unlocked once
a user's hand is recognized.

Door Switch Shunt:  This is the number of seconds the door can be open before
potentially triggering an alarm.  The Alarms tab in System Properties
(see page 25) and the Door Alarm on the Auxiliary (AUX) Settings (see
page 49) and Extended Settings (see page 52) tabs control whether this
causes an alarm.

Auto Unlock Timezone:  This controls when (if ever) the door is automatically
unlocked.  For example, you might want a door unlocked during normal
business hours, and you might want the door to require hand
recognition for access during other hours.  You would set up a time zone
that reflected the hours you wanted the door open and then pick that
time zone here.  (See page 62 for more on setting up time zones.)  When
you reached the start time, HandNet would unlock the door, and when
you reached the end of the time zone, HandNet would lock it again.
Leave this set to Never if you always want the door locked.
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Auxiliary
(AUX) Settings

Readers can communicate with
auxiliary devices like alarms, lights,
or security cameras.  HandKey
readers can communicate with one
auxiliary device; this screen controls
when and under what conditions
output is sent to that device.
HandKey II and HandKey CR
readers can communicate with up to
three auxiliary devices; this screen
controls the output to the first; the
Extended Setup tab (see page 52)
controls output to the second and
third.

To get to this screen, click a reader in the right pane of the Network window,
pick Properties from the Reader menu, and then click the Auxiliary (AUX)
Settings tab.

Set Auxiliary Alarm On:  Even though this says Set Auxiliary Alarm On, the
device doesn't have to be an alarm; this can trigger any type of auxiliary
device.  If a condition occurs and the corresponding box is checked,
HandNet turns auxiliary output on if it is during the time zone selected
at the bottom of the column on the right.

Auxiliary Input 1:  This occurs if the reader receives input from an
auxiliary input device.  This is irrelevant if you don't have an
auxiliary input device connected to the reader.

Auxiliary Input 2:  This occurs if the reader receives input from the
second auxiliary input device.  (HandKey II and HandKey CR
support two auxiliary input devices; HandKey readers support
just one.)  This is irrelevant if you don't have a second auxiliary
input device connected to the reader.

Invalid Access:  This occurs if someone repeatedly entered a valid ID
at a reader, and each time the reader does NOT recognize the
user's hand. (At the reader, the user would see the message ID
Refused, and the activity window would show the message
Access Denied.) The number of times that a user can try before
this occurs depends on the Number of Tries entry on the
Settings tab in the Reader Properties; see page 47. If this
occurs, someone might be trying to gain access with someone
else's ID.

Tamper:  This occurs if someone has shaken the reader roughly or
opened the reader. Unless someone was servicing the reader,
this message generally warrants further investigation.

Power Failure:  This occurs if the reader loses power from an
external source.  While this could just be due to an ordinary
power failure, sometimes someone trying to gain invalid access
will cut power in an attempt to disable alarm systems.

Duress Alarm:  This occurs if a user entered the duress code.  This
code indicates that the user is in trouble or that someone is
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forcing the user to give him/her access.  See page 47 for more
on setting up a duress code.

Door Alarm:  This occurs if the door connected to the reader is forced
open, or if the door is kept open for longer than allowed based
on the Door Switch Shunt Time on the Configuration tab in the
Reader Properties; see page 48.

F1 / F2 Key:  This occurs if the corresponding key was pressed on the
reader keypad.  (HandKey II and HandKey CR have F1 and F2
keys to the right of the number keys.  The HandKey reader
doesn't have these buttons, what you check here doesn't make
any difference for that type of reader.)

Time Zone Violation:  This occurs if a user enters a valid ID at a
reader, but the user isn't authorized to have access during the
hours or days of the week based on the time zone associated
with the reader in the access profile.

Try Again:  This occurs if a user enters a valid ID at a reader, but the
reader doesn’t recognize the user's hand.  (This situation
causes the Identity Unknown message in the Activity window.)
This could be just the result of incorrect hand placement.  (If
this happens repeatedly, HandNet generates the Invalid
Access condition above.)

Clear Auxiliary Alarm On:  If the auxiliary device is turned on, this controls
whether it will be shut off when someone gains valid access (that is,
enters a valid ID number and has his/her hand recognized).  If this is
checked, the alarm (or other auxiliary output) is turned off when a valid
user gains access through that reader; if this isn't checked, the output
continues until the time entered in the following entry ends or until you
go to the Reader menu, highlight Auxiliary Output, and pick Off; see
page 131.

Auxiliary Alarm Timeout:  This indicates the number of seconds that the
auxiliary device should be on for.

Auxiliary Alarm Time Zone: This controls when HandNet should turn output
to an auxiliary device on.  For example, if the auxiliary device were a set
of floodlights, it would only help to turn the lights on if the condition
occurred at night.  To do this, you would create a time zone for night
hours, and then assign that time zone here.  (See page 62 for more on
setting up time zones.)  If this says Always, HandNet turns output on
for the auxiliary device whenever the checked condition(s) occur.
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Passwords This screen controls the passwords
needed to access the menus available
through entered command mode on
the reader.  Generally the passwords
below are adequate since a user must
be set up with the appropriate
Authority Level on the Security tab in
User Properties (see page 92), and the
user must know how to get to these
menus in the reader before the
passwords below would do any good.

What is
available on
the different

reader menus

(1) Service: This lets you recalibrate the reader and change the reader's
status display.

(2) Setup: This lets you control reader setup issues including how the reader
is connected to your computer network, what language the reader
displays in, the date/time, etc.  

(3) Management: This lets you list users.

(4) Enrollment: This lets you add or remove users.

(5) Security:  This lets you control the passwords for the reader menus,
change time zones, enroll users who don't need hand access, etc.

For more detail, see the reader manual.
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Action Queue If the reader isn’t connected to
HandNet continuously (typically only
the case if HandNet communicates
with the reader by modem), this
screen lists changes that haven't
been sent to the reader yet.  These
actions will be sent to the reader the
next time the modem connects.

To get to this screen, click a reader in
the right pane of the Network
window, pick Properties from the
Reader menu, and click the Action Queue tab.

If there's been a change that requires that certain actions NOT be sent to
the reader, you can select those actions in the list and click Delete.

Extended
Setup

Readers can turn auxiliary devices
like alarms, lights, or security
cameras on or off.  HandKey II and
HandKey CR readers can
communicate with up to three
auxiliary devices; this screen controls
the output to the second and third
auxiliary devices; the Auxiliary
(AUX) Settings tab controls output to
the first; see page 49.  If you have a
HandKey (instead of a HandKey II or
HandKey CR), this screen doesn't not
apply since the HandKey only
supports one auxiliary device.

Ready String:  This is the text that appears in the reader display when the
reader is ready and waiting for the user to enter an ID.  For example,
if you wanted the readers to read “Enter ID” instead of “Ready” you
could change the text here.  You can enter up to 14 characters.  If you
want this text centered in the reader's display, add spaces before the
text if needed.

Log I/O Events:  This entry only applies to the HandPunch.  We don’t
recommend connecting a HandPunch to HandNet.  The HandPunch is
used for tracking time and attendance, which isn’t what HandNet is for.
If you do connect a HandPunch and this box is checked, the reader
records all activity (including invalid access attempts, door alarms,
accessing command mode on the reader, etc.); if you don’t have this
checked, the HandPunch only records successful accesses.  If you have
an ID3D HandKey, HandKey II, or HandKey CR, the reader records all
activity regardless of whether this is checked or not.
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AUX1/AUX2 Aux1 contains the settings for the second auxiliary device that can be
connected to a HandKey II or HandKey CR reader; Aux2 contains the
settings for the third.  (The settings for the first are on the Auxiliary (AUX)
Settings tab; see page 49.)

Alarm On:  Even though this says “Alarm On,” the device doesn't have to be
an alarm; this could trigger any type of auxiliary device.  If a condition
occurs and the corresponding box is checked, HandNet turns auxiliary
output on if it is during the time zone selected at the bottom of the
column on the right.

Auxiliary Input 1:  This occurs if the reader receives input from an
auxiliary input device.  This is irrelevant if you don't have an
auxiliary input device connected to the reader.

Auxiliary Input 2:  This occurs if the reader receives input from the
second auxiliary input device.  (HandKey II and HandKey CR
support two auxiliary input devices; HandKey readers support
just one.)  This is irrelevant if you don't have a second auxiliary
input device connected to the reader.

Door Alarm:  This occurs if the door connected to the reader is forced
open, or if the door is kept open for longer than allowed based
on the Door Switch Shunt Time on the Configuration tab in the
Reader Properties; see page 48.

Duress Alarm:  This occurs if a user entered the duress code.  This
code indicates that the user is in trouble or that someone is
forcing the user to give him/her access.  See page 47 for more
on setting up a duress code.

F1 / F2 Key:  This occurs if the corresponding key was pressed on the
reader keypad.  (HandKey II and HandKey CR have F1 and F2
keys to the right of the number keys.  The HandKey reader
doesn't have these buttons, what you check here doesn't make
any difference for that type of reader.)

Invalid Access:  This occurs if someone repeatedly entered a valid ID
at a reader, and each time the reader does NOT recognize the
user's hand. (At the reader, the user would see the message ID
Refused, and the activity window would show the message
“Access Denied.”) The number of times that a user can try
before this occurs depends on the Number of Tries entry on the
Settings tab in the Reader Properties. If this occurs, someone
might be trying to gain access with someone else's ID.

Power Failure:  This occurs if the reader loses power from an
external source.  While this could just be due to an ordinary
power failure, sometimes someone trying to gain invalid access
will cut power in an attempt to disable alarm systems.

Tamper:  This occurs if someone has shaken the reader roughly or
opened the reader. Unless someone was servicing the reader,
this message generally warrants further investigation.

Time Zone Violation:  This occurs if a user enters a valid ID at a
reader, but the user isn't authorized to have access during the
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hours or days of the week based on the time zone associated
with the reader in the access profile.

Try Again:  This occurs if a user enters a valid ID at a reader, but the
reader does not recognize the user's hand.  This could be just
the result of incorrect hand placement.  (If someone repeatedly
entered a valid ID at a reader, and each time the reader does
NOT recognize the user's hand, this would generate the
Invalid Access condition above.)

Clear Auxiliary Alarm On:  If the auxiliary device is turned on, this controls
whether it will be shut off when someone gains valid access (that is,
enters a valid ID number and has his/her hand recognized).  If this is
checked, the alarm (or other auxiliary output) is turned off when a valid
user gains access through that reader; if this isn't checked, the output
continues until the time entered in the following entry ends or until you
go to the Reader menu, highlight Auxiliary Output, and pick Off; see
page 131.

Timeout:  This indicates the number of seconds that the auxiliary device
should be on for.

Time Zone: This controls when HandNet should turn output to an auxiliary
device on.  For example, if the auxiliary device were a set of floodlights,
it would only help to turn the lights on if the condition occurred at night.
To do this, you would create a time zone for night hours, and then
assign that time zone here.  (See page 62 for more on setting up time
zones.)  If this says Always, HandNet turns output on for the auxiliary
device whenever the checked condition(s) occur.

Information This screen contains information
about the reader.  A key piece of
information on this screen is the
Users Enrolled/Capacity:  this
reflects the amount of available space
in the reader.  For example, the
screen below reflects a reader with
498 users and space for up to 512
users.  You could only add 14 more
users before this reader reached its
limit.  If you were approaching this
limit, you would want to consider a
memory upgrade for the reader so it
would have space for additional
users.

Most of the other information on this screen is helpful if your reader needs
service, but not relevant to the ongoing use of the reader.

To get to this screen, click a reader in the right pane of the Network window,
pick Properties from the Reader menu, and then click the Information tab.

�����
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Configuring the Physical Reader
While most of the information in the reader is controlled through HandNet,
you must initially set up certain settings in the reader so it can
communicate with HandNet.  You do this through the command menus on
the reader.

For readers with a network (ethernet) card:  The IP address in this reader
must match the IP address on the Connection tab in Site Properties;
see page 39.

For a reader connected by serial port or connected as part of a chain of
readers:  The address in the reader must match the address on the
General tab in Reader Properties; see page 45.  The serial settings
must also be correct, and the baud rate must match the baud rate
on the Connection tab in Site Properties; see page 35.

We don't recommend changing any other settings through the reader
command menus.  All other settings can be controlled through Reader
Properties in HandNet; see page 45.  (If you were to make other changes
directly in the reader, these would be overridden by the settings in HandNet
when you enabled the reader.)

Getting to the
Setup Menu in

the Reader

1. Enter command mode on the reader:
If you have a HandKey II or HandKey CR reader:  Press CLEAR, and then

press ENTER.
If you have an ID3D HandKey reader:  Press # AND *.  (You can press

them at the same time, or one after the other.)

If you haven't used the reader with HandNet before, or if you've used it
with HandNet and cleared its memory, the display looks like this.

Type the password for the setup menu and press ENTER or #.  If you
haven't changed it, the password is 2.

If you've previously used the reader with HandNet and are
reconfiguring it for another site or location, you may see:

If the display looks like this, type your user ID and press ENTER or #.
The reader will ask you to place your hand.  Once you place it, you
should then see the Enter Password display shown above.  Type the
password for the setup menu and press ENTER or #.  If you haven't
changed it, the password is 2.

  ENTER PASSWORD

READY      
*:
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Changing the
Reader

Address

You must set the address in readers that are connected to the computer by
a serial cable, and in readers that are connected to another reader (that is,
readers that aren’t the first reader in the site).  You can’t change the address
in a reader that has an ethernet card; these readers automatically have an
address of 0 (zero).

The following steps are specific to the HandKey II and CR; the menus are
slightly different in other readers.  Please see the manual that came with
the reader if you aren’t sure how to find the correspond settings in your
reader.

1. If you haven't already done so, follow the steps on page 55 for getting
to the reader setup menu.

2. Press the * / NO button until the display looks like this:

3. Press the # / YES button.  The display will look like this:

4. Type the new address.  The address you enter must match the address
on the General tab in Reader Properties; see page 45.  Press YES or
ENTER.  The display returns to:

5. If you are done changing settings, press CLEAR to leave the reader
command menu.  If you need to change others settings, press NO until
you get to the next setting you need to change.

   SET ADDRESS
  * NO    YES #

 RDR ADD ID 1
 NEW?:

   SET ADDRESS
  * NO    YES #
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Changing the
Serial Settings
and Baud Rate

You must have appropriate serial settings and baud rate in readers that are
connected to the computer by a serial cable, and in readers that are
connected to another reader (that is, readers that aren’t the first reader in
the site).  These settings don’t apply to a reader with an ethernet card.

The following steps are specific to the HandKey II and CR; the menus are
slightly different in other readers.  Please see the manual that came with
the reader if you aren’t sure how to find the correspond settings in your
reader.

1. If you haven't already done so, follow the steps on page 55 for getting
to the reader setup menu.

2. Press the NO button until the display looks like this:

3. Press the YES button.  The display will look like this:

4. Typically you will answer YES here. The display now asks for the baud
rate.  The baud rate here must match the rate on the Connection tab in
Site Properties.  Generally 9600 is appropriate.

If you have a HandKet II or HandKey CR:
The display will show the baud rate:

To accept the rate shown and continue, press YES.  To change
the rate, press NO to cycle through the choices until you find
the one you want.

If you have an ID3D HandKey:  The baud rate is represented by a code:

For example, for 9600, you would enter the code of 2.
5. The reader will display:

Unless you have a printer connected directly to the reader, you would
typically answer NO here.  If you have a printer directly connected to
this reader, answer YES.  (Most users working with HandNet print from
HandNet rather than connecting a printer directly to the reader.)  The
only other time you might say YES here was if you had a single reader
connected directly to HandNet with a serial port; there is a way to wire

    SET SERIAL
   * NO    YES #

 Set RS-485/422?
   * NO    YES #

 9600 baud
  * NO     YES #

baud rate code baud rate code

38.4K 0 2400 4

19.2 1 1200 5

9600 2 600 6

4800 3 300 7

   Set RS-232?
  * NO     YES #
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the connection to use RS-232.  (If this were the case, you would say YES,
pick the appropriate baud rate, and then indicate that RS-232 was
connected to 1-Host (that is, HandNet).)

6. Once you are done, you see the Set Serial display again:

7. Press CLEAR to leave the command menu.

    SET SERIAL
   * NO    YES #
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Changing the
IP Address in a
Reader with an
Ethernet Card

You must set the IP address in a reader with an ethernet card.  Before you
do this, get the appropriate IP address and gateway (if needed) from your
network administrator.  If you have a WAN (wide area network), you also
need the subnet mask; only certain subnet masks are supported; see the
table below.

1. If you haven't already done so, follow the steps on page 55 for getting
to the reader setup menu.

2. Press the NO button until the display looks like this:

3. Press the YES button.  The display will look like this:

If the display says “Set RS-485/422?” at this point, the reader does NOT
have a network card.  Contact your dealer if you need to get one.

4. Quickly type the correct address; if you pause for more than about four
seconds while entering the IP address, the reader advances to the next
display without saving your change.  The address will have four parts
separated by periods.  Enter each part as three digits; if one part has
less that four digits, add zeros before that part of the number to make
it three digits.  You don't have to enter the periods.  For example, if your
administrator gave you the address 192.9.210.10, you would enter:

 192 009 210 010

This address must match the IP address on the Connection tab in Site
Properties; see page 39.  Press YES or ENTER.  The display will now look
like this:

5. If your network administrator has told you to enter a gateway, do so;
otherwise press YES or ENTER.  As with the IP address, if you change
this, you must type fairly quickly; if you pause for more than about four
seconds while entering the gateway, the reader advances to the next
display without saving your change.  Once press ENTER, you see:

6. If you are communicating over a LAN (local area network), type 0 for
the Host Bits and press YES or ENTER.  If you have a WAN, enter the
number from the table below that corresponds to your subnet mask.

    SET SERIAL
  * NO    YES #

 IP ADDRESS
 000.000.000.000

 GATEWAY
 000.000.000.000

 HOST BITS: 0
 NEW?
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(Only the subnet masks listed are currently supported.)  If you aren't
sure, check with your network administrator.

7. The reader will display:

The speed you choose should match the baud rate you are setting in the
rest of the readers in this site.  Generally 9600 is appropriate.  To accept
the rate shown and continue, press YES.  To change the rate, press NO
to cycle through the choices until you find the one you want.

Once you press YES, the reader display returns to:

8. If you missed one of the settings because the reader display changed too
quickly for you, press YES to go through the settings again.  If you are
done changing settings, press CLEAR to leave the command menus.

9. If you need the changes to take effect immediately, disconnect the
power from the reader, wait a few seconds, and then connect the power
again.  This resets the reader.  If you don't do this, it may take up to 6
minutes for the changes to take effect.
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For this 
subnet mask:

Enter this for 
the host bits:

For this 
subnet mask:

Enter this for 
the host bits:

255.255.255.255 0 255.255.224.0 13

255.255.255.254 1 255.255.192.0 14

255.255.255.252 2 255.255.128.0 15

255.255.255.248 3 255.255.0.0 16

255.255.255.240 4 255.254.0.0 17

255.255.255.224 5 255.252.0.0 18

255.255.255.192 6 255.248.0.0 19

255.255.255.128 7 255.240.0.0 20

255.255.255.0 8 255.224.0.0 21

255.255.254.0 9 255.192.0.0 22

255.255.252.0 10 255.128.0.0 23

255.255.248.0 11 255.0.0.0 24

255.255.240.0 12   

 9600 baud
  * NO    YES #

    SET SERIAL
  * NO    YES #
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Resending Information to a Reader
Why You Might

Need to
Resend

Information

While HandNet automatically sends the appropriate information to
readers, occasionally you will need to use this when correcting a problem
with a reader.  You can do this with  Download  on the Reader menu.

Getting to the
Download

Option

To do this, select one or more readers, and go to the
Reader menu, click Download, and then click the
type of information to send.

Time:  This sends the current time from the computer
to the selected reader(s).  You typically only need
to use this option if the time changed (for
example, for daylight savings time).  You can
select all of your readers and send the time to all
of them at once, or you can select specific readers. 

Time Zones: This sends time zone and holiday information to the selected
reader(s).  You need to download this information if you change Time
Zones (page 62) or Holidays (see page 66).

Setup:  This sends configuration information to the selected readers.  In
most cases this is done automatically.

Users:  After adding users, you need to download them to the hand readers
so the readers will recognize the new users.  This sends all current
users to the selected readers.

All:  This sends Time, Time Zones, Setup, and User information to the
selected reader(s).  You would use this when you set up a new reader so
the reader had all the needed information.

Confirming
That You Want

to Send
Information to

the Reader

Whenever you choose to download information to readers, HandNet asks
you to confirm that you want to download to the selected reader.  Click Yes
to continue.
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Settings that Control User Access

Setting Up Time Zones
What Time
Zones Are

Time zones are periods of time on different days of the week when users can
have access.  There’s no connection between what we call time zones in
HandNet and the time zones we usually think of that have to do with
different times around the world.  This doesn’t have anything to do with
Eastern, Central, Mountain, or Pacific time; it only has to do with
controlling which hours of the day access is available through readers.

When You
Need to Set Up

Time Zones

If you want some users to be able to use certain readers only during certain
hours or on certain days of the week, time zones let you identify when access
is available.  For example, suppose some users should only be able to gain
access through certain readers between 8:00 AM and 5:00 PM, Monday
through Friday.  You would create a time zone that identified these times
and days, associate that time zone with appropriate readers using an access
profile, and then assign that access profile to the users.  After you did this,
users with that access profile would only have access during the times you
identified in the time zone.

You can also use time zones to determine when certain doors should be
automatically unlocked; see Automatically Unlocking a Door on a
Scheduled Basis on page 130.

If users should have different access on holidays than on other days, you can
set different hours for holidays in the time zone.  You will have to also set
up holidays; see page 66.

When You
Don't Need to

Set Up Time
Zones

If you don't need to limit access by day or time (that is, if users could use the
readers 24 hours a day, 7 days a week if they wanted), and if you don't want
doors to unlock automatically, you don't need to set up time zones.
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Getting to the
List of Time

Zones

1. Click the View menu.
2. Click Time Zones.  You see a screen like the one below (though the time

zones listed will be different).  From here you can add, change, or delete
time zones.

The first time zone is Always and the last (#61) is Never; you can't change
either of these.

Adding or
Changing Time

Zones

To add a time zone, click one of the blank lines in the time zone list and click
Edit.  To change a time zone, click the time zone to change and click Edit.
Change the Time Zone Definition screen (see below) as needed and then
click OK to return to this list.  You can then add or change another or click
Close when done.

Deleting Time
Zones

Click the time zone and click Delete.  The program asks if you are sure you
want to delete the time zone.  Click Yes.

If you try to delete a time zone and get a message that the time zone is used
in an access profile, if you still want to delete it, you must close the time zone
window, go to access profiles and select a different time zone for each reader
that had this time zone selected.

Time Zone
Definition

Screen

This screen determines what hours access is available on different days of
the week. A time zone is active if the time is equal to or after the start time
and before the stop time, and if the day of the week matches one of those
checked.

Name:  Enter a name that will be clear to you so that when you associate the
time zone with a reader in an access profile, you'll be sure to pick the
right one.
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You can assign four different periods in each time zone if you need them (for
example, if you want to give access during different hours on different days).
Leave lines that you don't need blank.

Start/Stop Times:  Enter hours after noon using military time.  Use the chart
below or see the examples if you need help.  Times are divided into
tenths of an hour, so HandNet rounds minutes to the nearest six
minute interval.  For example, if you enter 8:02, the program rounds
this to 8:00; if you enter 8:03, the program rounds it to 8:06.

If a time zone must cross midnight (for example, if you want to give
access between 8:00 PM and 4:00 AM), you must use two lines to create
that access time.  The first line would give access from 20:00 to 24:00
(that is, 8:00 PM to midnight), and the next line would give access on the
same days of the week from 0:00 to 4:00 (that is, midnight to 4:00 AM).
See the third example on the following page.

Days of the Week:  Check the boxes for each of the day of the week that access
should be available.  The letters over the boxes correspond to the days
of the week (Sunday through Saturday); H stands for holiday.  If access
is different on holidays than on other days, you must also set up
holidays; see page 66.  See the examples on the following page.

Click OK when done.

Enter on the
Time Zone screen

Enter on the 
Time Zone screen

noon 12:00 7:00 PM 19:00

1:00 PM 13:00 8:00 PM 20:00

2:00 PM 14:00 9:00 PM 21:00

3:00 PM 15:00 10:00 PM 22:00

4:00 PM 16:00 11:00 PM 23:00

5:00 PM 17:00 midnight 00:00 if a start time; 
24:00 if a stop time

6:00 PM 18:00
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Examples of
Time Zone

Settings

These settings give access between 8:00 AM and 6:00 PM, Monday through
Friday.  They don't give any access on Saturday, Sunday, or Holidays.  The
blue bar in the center section of the screen shows when access is available.

The following settings give access from 7:00 to 11:30 in the morning on
weekdays, from 1:30 in the afternoon to 6:00 PM also on weekdays, from 9:00
in the morning to 1:30 in the afternoon on Saturdays, and from 5:00 PM to
midnight on Sundays and Holidays.

The following settings show how to cross midnight.  This gives access from
8:00 PM through 4:00 AM any day of the week.  Notice that this requires two
lines to set up:  the first going from 8:00 PM to midnight, and the next going
from midnight to 4:00 AM.

�����



Settings that Control User Access   •   Setting Up Holidays 66

Setting Up Holidays 

When You
Need to Set Up

Holidays

If you want to prevent access on holidays or to give different access on
holidays than on other days, the holidays list identifies when those holidays
are. When you reach a holiday in the list, HandNet applies the holiday
access times instead of the regular access times.  (If you set holidays up,
you'll also have to set up time zones to indicate what access users should
have on different days; see page 62 for more on setting up time zones.)

When You
Don't Need to
Set Holidays

Up

If you don't give different access on holidays than on other days, you don't
need to set up any holidays.

Adjusting
Holidays Each

Year

If you set holidays up, remember to return to the holidays setup at the
beginning of each year to adjust each holiday that is celebrated on a
different date than the previous year.  For example, Thanksgiving,
Memorial Day, and Labor Day are on different dates each year.  Also, while
holidays like Christmas and New Year's are always on the same date, when
these holidays fall on a weekend, the day they are taken off is sometimes on
a different date.

Getting to the
Holidays List

1. Click View from the main menu bar.
2. Click Holidays.  You see a list like this one below.  From here you can

add, change, or delete holidays.

Adding or
Changing
Holidays

To add a holiday, click Add; to change a holiday,
click the holiday in the list and then click Edit.
When you add or edit, you see this screen:

Name:  Enter a name to help you identify the
holiday.

Month:  Click this entry and pick the month from
the list.  (You could also press TAB from the
Name entry and then type the first letter of the month.  If more than one
month begins with the same letter, typing that letter cycles through
those months.)

Day:  Click this entry and pick the day from the list. (You could also press
TAB from the Month entry and then type the first digit.  For example, if
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you wanted to get to 25, you would type 2 several times.  The first time
you typed the 2, the date would show 2; when you typed 2 a second time,
you would see 20; typing two again would switch to 21; you would
repeat this until you got to the number you needed.)

Click OK when each entry is correct.

Deleting
Holidays

To delete a holiday:  Click the holiday in the list and click Delete.

�����



Settings that Control User Access   •   Setting Up Access Profiles 68

Setting Up Access Profiles

When You
Need to Set Up

Access
Profiles

If some users can only use certain hand readers and/or only use them at
certain times or on certain days, access profiles define when each type of
user can use each reader.  For example, suppose your maintenance staff
should have access to the maintenance rooms seven days a week, your office
staff should have access to the office but only during business hours, and
your supervisors should have access to everything at any time.  You would
create three access profiles:  one for supervisors, one for office staff, and one
for maintenance personnel.  These profiles would identify which readers
each group could use.  In these profiles you would also identify which time
periods each group could use each reader.  (You would set up these time
periods first using Time Zones.)  After creating these different profiles,
whenever you added a user, you would just identify which group the user
was a part of, and the access profile for that group would automatically give
the appropriate access. 

To limit access to certain days or times, you must set up time zones before
creating access profiles; see page 62 for more on setting up time zones.

When You
Don't Need to

Set Up Access
Profiles

If you want all users to be able to use every reader any time, you don't need
to set up access profiles.  HandNet comes set up with an Always profile that
lets users use any reader in the system 24 hours per day, seven days per
week.  (It also has a Never profile that doesn't let the user verify at any
reader at any time.) 

Getting to the
List of Access

Profiles

1. Click the View menu from the main menu bar.
2. Click Access Profiles.  You see a screen like the one below (though the

profiles listed will be different).  From here you can add, change, or
delete access profiles.

The Default Time Zone shown on this list does NOT reflect the time
zones associated with the readers in this profile; it only reflects the time
zone that HandNet initially picks if you associate another reader with
this profile.  Except for the Always profile, this column always says
Never.

Adding an
Access Profile

Click the Add button to add an access profile.  This starts the New Access
Profile Wizard.
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New Access
Profile Wizard,

Screen 1

You see the New Access Profile Wizard when you add a new access profile to
the list of access profiles.

Name:  Enter a name that describes the group of users that this access
profile will be used for.  For example, if this profile gives access that is
appropriate for all of your maintenance staff, you could use that for the
name.  The important thing is for the name to be clear so that you don't
give inappropriate access to users.

Click the Next button to go to the next screen.

New Access
Profile Wizard,

Screen 2

The second screen in the New Access Profile Wizard lists all of your readers.
(Typically you'll have many more than the two shown in the example below.)
Select each reader that you want to give access to with this profile, and then
click Next.

New Access
Profile Wizard,

Screen 3

The third and final New Access Profile Wizard screen shows all of the
readers that you selected on the previous screen.  (If you discover that you
missed a reader on the previous screen, click the Back button to return to
the list of all readers and select it there.)
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When you come to this screen, each reader has a time zone of Never; you
must change the time zone for each reader to give access to that reader
through this profile.

To associate time zones with the readers:

1. Select one or more readers on the list.  If you forget to select readers,
HandNet still lets you do the following step but it won't have any
effect.

2. Click on the entry under Choose one or more readers... and select a time
zone there.  HandNet uses that time zone for each selected reader.  

If you need to associate a different time zone with some readers, repeat
these steps until you have specified a time zone for each reader.  For
example, suppose you were creating an access profile for maintenance
workers, and suppose these workers had access to building entrances and
maintenance facilities 24 hours a day, but they only had access to the
business offices during normal business hours.  You would select the
entrance and maintenance readers and associate a time zone of Always with
them.  You would then select the business office readers and associate your
normal business hours time zone with those readers.

Changing an
Access Profile

To change an access profile, click
it on the list and then click the
Edit button.  That brings up a
list of readers that have been
associated with the profile.  The
list looks like this:

To add another reader to those
associated with this profile:
Click the Add button to
bring up the Access Profile
Override box (shown on the following page).  Complete the entries there
and click OK.

To change the time zone a reader is accessible with this profile:  Click the reader
in the list and click Edit to bring up the Access Profile Override box.
Click the Time Zone entry, select the appropriate time zone, and then
click OK.

To change the time zone for several readers at once:  Hold the CTRL key down
and click each reader that you want to change the time zone for.  When
all the appropriate readers are selected, click Edit.  This brings up the
Access Profile Override box but you can only change the Time Zone
entry.  Click the Time Zone entry, select the appropriate time zone, and
then click OK.

To remove one or more readers from this access profile: Select the reader(s) in
the list and click Delete.

Click Close to return to the list of profiles.
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Access Profile
Override Box

You see this same screen whether you are adding a reader to a profile or
editing a reader that you've added previously.  (When adding the entries are
initially blank; when editing, the entries are filled in with your previous
choices.)

Reader:  Click this to choose a reader that should be associated with this
profile.  This only lists readers that haven't already been added to this
profile.  If you click this and an empty pick box comes up, then you've
already added all readers to this profile.  This entry is disabled if you
are changing several readers at once.

Time Zone:  Click this and pick the time zone that the users with this profile
should have access to the selected reader(s).  If you have selected
several readers, this changes all of them at once.

Click OK to return to the list of readers in this profile.

Deleting an
Access Profile

To delete an access profile, click the profile on the list and click the Delete
button.  HandNet doesn't ask you to confirm the deletion, so make sure you
pick the right one.

If you get a message that the access profile you are trying to delete is still
assigned to a user, go to the list of users, double-click the user to go to the
User Properties, click the Security tab, and select a different access profile
for the user there.  The message only lists the last user that the profile was
assigned to, so there may be other users that also use the profile.  Check the
list of users to see if any other users use that profile.  (Click the heading of
the profile column in the user list to sort by profile; that will put all users
with each profile together.)  If you find any other users using the profile you
want to delete, select a different profile for each of them as well.  Once no
users are using the profile, you can return to this option and delete the
profile.
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Adding and Maintaining Users

Users Window 
The users window lists every user that is in HandNet.  To open this window,
pick Users from the View menu or press CTRL-U.

Understanding
the Icons to

the Left of the
Name

Changing How
the User List is

Sorted

You can sort the list of users using the information in any column by
clicking on the column heading.  For example, to sort the user list
alphabetically by name, click on the name heading.  If you click on the same
heading again, it will sort the list in reverse order.  (For example, using the
name, it would sort from Z to A.)  Usually sorting by name or ID is most
useful, but occasionally you might sort by another column to put all similar
users together.  For example, if you were preparing to change or delete a
particular access profile, you might sort by the access profile column so that
all users with that profile would be together on the list.

Rearranging
Columns in the

User Window

To move any column, click the column heading and hold the mouse down.
With the mouse held down, drag the column heading to the left or right.  See
the on-line help for an example of this.

 No icon indicates that the user is enrolled able to use any readers
permitted by the access profile.

The no access icon indicates that the user is not enrolled yet and
hence won't have access to any readers.  You must enroll the user
to give access; see page 88.

The green light indicates that the user currently has access, and
that the limited access feature was used to so this access will
automatically expire at some point.  See page 93 for more about
limited access.

The black dot indicates that the limited access feature was used to
set a begin and end date/time for this user's access, and the user
does NOT have access because the access period hasn't started yet.
See page 93 for more about limited access.

The red light indicates that the limited access feature was used to
set a begin and end date/time for this user's access, and the user
does NOT have access because the access period has ended.  See
page 93 for more about limited access.
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You might want to move columns to keep important information like user
IDs out of view, or, if you have created custom user entries, you might want
to move them to where you can see them, since they are initially out of view.

F5 restores all columns to the positions they had when you started HandNet.
If you want HandNet to save the new column positions, exit the HandNet
program and come back in.  HandNet then uses your changed column
positions as the new standard or default.

Changing
Column
Widths

You can also change the width of a column by pointing to the edge of the
column heading, holding the mouse down, and then dragging the edge of the
column to the desired position.  This lets you fit more columns in the
window.  (Or, if you wanted to hide information from the casual observer,
you could make columns wider to push other columns out of view.)  See the
on-line help for an example of this.

F5 restores all columns to the widths they had when you started HandNet.
If you want HandNet to save the new column widths, exit the HandNet
program and come back in.  HandNet then uses your changed column
widths as the new standard or default.

Columns of
Information in

the User
Window

User ID:  The ID number the user must enter at the reader to gain access.

Access Profile:  The profile determines which readers the user can access
and when.  You set up access profiles using Access Profiles on the View
menu.  You can change a user's access profile on the Security tab in User
Properties; see page 92.

Authority Level:  This indicates whether the user is allowed to access the
command menus on the readers.  For most users, this should say None.
You can change a user's authority level on the Security tab in User
Properties; see page 92.

Reject Threshold:  The reject threshold controls how closely a user's hand
must match the stored hand profile for the user to gain access.  If this
says Default, then HandNet uses the Reject Threshold on the
Configuration tab in the Reader Properties (see page 48).  If this says
Default* (with an asterisk), this means the user does not need hand
recognition to gain access because the user was set up with a special
enrollment; see page 77. If this shows a number, someone chose to
override the standard reject threshold on the Security tab in User
Properties; see page 93.  A lower number requires a very precise match
to gain access; a high number requires the hand to match less exactly.
30 is the lowest number possible; 250 is the highest.  One might use a
lower number for users with access to the highest security areas; one
might need a higher number if a user had arthritis or other hand
condition that made it impossible to consistently place the hand on the
reader in exactly the same position.

Last Site:  This lists the last site where the user gained access.  This is blank
for a new user who hasn't accessed a reader yet.
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Last Reader:  This lists the last reader the user gained access through.  This
is blank for a new user who hasn't accessed a reader yet.

Last Time Used:  This shows the date and time of the user's last access.

Limited State:  This says Unlimited for users who aren't set up to only have
access for a limited period of time, that is, for users whose access will
continue indefinitely.  For users who are set up to only have access for
a limited period of time, this says Waiting if  the access period hasn't
started yet, Limiting if the user currently has access, and Expired if the
user's access period has ended.  See page 93 for more about limited
access.

Limited Start Time:  If this user has been set up to have access for a limited
period of time, this shows the date and time that the user's access
begins.  HandNet won't give the user access before this date/time.  This
is blank for other users.  See page 93 for more about limited access.

Limited End Time:  If this user has been set up to have access for a limited
period of time, this shows the date and time that the user's access ends.
HandNet won't give the user access after this date/time.  This is blank
for other users.  See page 93 for more about limited access.

Additional Custom Columns:  If you created any custom user entries, those
columns would be listed as well.  See page 97 for more about adding
custom entries.
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Adding Users Overview

Before You
Add Users

If you are going to limit access to specific time periods or specific readers,
set up Time Zones (see page 62) and Access Profiles (see page 68) before you
set your users up.

Choosing How
to Add the

Users

If you've already set up users in a stand alone reader:  You don't need to add
users; you can upload user information from the reader; see Getting
User Information from a Reader on page 99.

If you've been using one of our MS-DOS HandNet products (HandNet or HandNet
Plus):  You don't need to add users; you can import them from
HandNet(+); see page 98.

If you only have one user to add, if you don't assign ID numbers sequentially, if
you're adding users with different access profiles, if you want to fill in custom
entries when adding the users, or if users choose their own ID numbers:  Add
a single new user; see page 77.

If a user needs access without hand recognition:  Add a single new user and
choose the special enrollment option.  Before you do this, read Adding
a User Who Has Access Without Hand Recognition below.

If you have many new users with the same access profile and you want
automatically assigned ID numbers:  Add multiple new users; see page 82.

Adding a User
Who Has

Access
Without Hand

Recognition

If a user has severe arthritis, missing fingers, or other hand deformities
that keep the user's hand from being recognized, you can give the user
access without hand recognition.  (If you choose this, the reader still asks
the user to place a hand on the reader so it won't be apparent to others that
hand recognition isn't required, but the reader doesn't check the image of
the hand; it gives access regardless of whose hand is placed there.)  Since
bypassing hand recognition gives you reduced security, only use
this as a last resort.  Try these options first:

If the user only has a problem with the right hand:  Enroll the user using the
left hand.  (The user will place the hand palm up on the reader.)

If the user has all of his/her fingers and is just having trouble with placing the
hand consistently:  On the Security screen in User Properties, check
Override the reader's reject threshold, and drag the pointer to the
far right (the Less Sensitive side).  This causes the reader to be
more tolerant of what it considers a match for that user's hand.

If these options aren't possible, or if you try them and they don't work, then
you will have to set the user up so that hand recognition isn't required.  To
do this, follow the steps below.

1. If you have already added this user, open the user window, click the
user once, press the DEL key (or pick Delete from the User menu), and
confirm that you want to delete the user.

2. Click the User menu and then click Add New….  This takes you to the
first screen of the New User Wizard.
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3. Check the Special Enrollment box.  Since this option does give lower
security, HandNet asks you to confirm that you want to do this; click
Yes.

4. Click the Next button.
5. Complete the rest of the process just as you would for any other new

user.
6. Since the reader doesn't have to recognize this user's hand, you don't

need to enroll this user; once you click Finish, the process is done for
this user.

Allowing Users
to be Added at

the Reader

HandNet is initially set up to only allow new users to be added in the
program; you can enroll a user at a reader, but you can't add a new user
there.  If you want to be able to add and enroll a new user at a reader
without adding the user to HandNet first, do this:

1. Click the View menu.
2. Click Settings.
3. Click the Security tab.
4. Check the box by Do not delete unauthorized enrollments.
5. Underneath this, indicate what access profile should be given to a user

who is added at a reader.  (If you don't want the user to be able to access
any readers until you change them in HandNet, choose Never.)

6. Click the OK button at the bottom of the box.

Preventing
Users from

Being Added
at Readers

Follow the steps above to get to the Security tab and make sure that Do not
delete unauthorized enrollments is NOT checked.
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Adding a Single New User

Beginning the
Process

To begin adding a new user, pick Add New... from the User menu.

Special Enrollment:  Check this box only if the user has severe hand
deformities that require you to give the user access without hand
recognition.  This box is disabled if you are adding multiple users; if you
are enrolling a user without hand access, you must add a single user.

Click Next to continue.
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Adding a Single User

1. Click the User menu and then click Add New….  This takes you to the
first screen of the New User Wizard.

2. Add a single new user is automatically selected, so click Next to
continue.

3. On the Name/ID screen, enter the Name and the ID number you are
assigning to that user, and then click Next to continue.

4. On the Security screen, choose the access profile, authority level, and
other security options.  If you have set up custom user entries, click
Next; otherwise click Finish.

5. If you see the Custom entries screen, fill in the column on the right and
then click Finish.

6. Once you are done adding the user, you must enroll the user before the
user will have access; see page 88.
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Name/ID
screen

This is the second screen in the process of adding a single new user:

Name:  Enter the user's name.

If you want to sort the list of users by last name:  Enter the last name first.
For example, if the user's name were “Sam Gamgee,” you would
enter “Gamgee, Sam.”

If you have two users with the same name:  You must enter a unique name
for each user.  If two users have the same name, you might add a
middle initial, or you might add a job description after each.  For
example, if you had two users named John Jones, you might enter
something like Jones, John (engineer) and Jones, John
(maintenance).

ID Number:  Each number must be unique.  (If you could give the same
number to two users, the reader would not know which was trying to
gain access.)  Longer numbers are slightly more secure, but four or five
digits are generally adequate in context where user's must enter the
number.  You may enter up to ten digits if you don't use a duress code,
or up to nine digits if you do use a duress code.  If you use a duress code,
make sure that you don't create an ID that begins with that digit.  (See
page 47 for more about duress codes.)  If you have set up an ID length
on the Settings tab in the Reader Properties (see page 47), make sure
that you don't create an ID that is longer than this.

If you use Wiegand card readers:  Enter the ID number that is stored on
the card.

Don't begin an ID with 0 (zero) if you are going to enroll the user with the
command menus on the reader:  HandNet lets you enroll a user by
either picking Enroll from the Reader menu, or by using the
command menus on the reader.  (See page 88 for more about these
options.)  If you are going to use the command menus on the reader,
the ID Number should not begin with 0 (zero).  While HandNet
distinguishes between 5 and 0005, the process of adding a user
from the reader command menu doesn’t.  This means that if you
create a user with an ID of 0005 in HandNet and try to enroll that
user with the command menus on the reader, when you type 0005,
the reader thinks you are enrolling user 5.  This won't correspond
with 0005 in HandNet.  If you are going to use Enroll on the Reader
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menu, you can begin an ID with 0.  (If you are never going to begin
an ID with 0, this might be a good choice for a duress code if you use
one.)

Security
Screen

This screen controls what this user has access to and when.

Select an access profile to control which readers the user can use at what times:
Click this entry for a list of available access profiles.  If this user can use
all readers at all times, choose Always.  If you don't want the user to be
able to use any readers, choose Never.  For other access, select the
appropriate profile.  You must set access profiles up before they are
available here.  See page 68 for more on setting up access profiles.

Select an authority level to allow users to access reader commands:  This
determines what the user can do at the reader.  Each higher level gives
access to the lower levels as well.  For example, a user with an authority
level of 4 can also use the level 1, 2 and 3 menus.  Except for
recalibrating the reader (part of level 1), and enrolling a user if you
haven't purchased the upgrade to the full feature set, HandNet can
control every setting in the reader, so there is generally no need to
control settings through the reader menus.

None: This lets the reader gain access through the reader, but not
use the command menus in the reader to change the reader's
settings.  This choice is appropriate for most users.

(1) Service: This lets you recalibrate the reader and change the
reader's status display.

(2) Setup: This lets you control reader setup issues including how
the reader is connected to your computer network, what
language the reader displays in, the date/time, etc.  

(3) Management: This lets you list users.
(4) Enrollment: This lets you add or remove users.
(5) Security:  This lets you control the passwords for the reader

menus, change time zones, enroll users who don't need hand
access, etc.

See the HandKey manual for more on directly changing settings
through the reader.
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Limited
Access

Enable limited access:  This gives a user access for a specific date range.  For
example, suppose a contractor or temporary employee was going to be
working in your building for a month.  Or suppose an employee gave
notice that he/she was leaving for a new job in two weeks.  Once this
period was over, you wouldn't want these users to have access.  Rather
than having to remember to disable the user on the appropriate date,
this option lets you set a start and end date/time so the user is
automatically enabled and disabled at the appropriate points.

To set up start and end date/times, check the box by this button and
then click the Edit Access button.  (This button only works if you have
checked the box.)  This takes you to the Edit Limited Access screen:

To change either start or end date or time, click the corresponding entry
and pick from the list that comes up.

This option is disabled if you haven't purchased the license upgrade to
the full feature set of version 2.0.

This option is NOT for limiting access to specific readers or for specific
times of the day; to control that, use the Access Profiles entry.

Override the reader’s reject threshold (for users with special requirements):  For
users with a physical condition like arthritis that prevents them from
placing their hands on the reader in exactly the same way each time,
this option lets you control how exact the hand match must be for the
reader to grant access.  

Normally you wouldn't change this when adding the user.  Instead, add
and enroll the user, and then see if the user is having trouble gaining
access.  If a user is having trouble getting access consistently, go to the
Security tab in the User Properties and change this entry there.  You
would check this box and then slide the pointer further to the right (the
Less Sensitive side).  If a user has a really severe hand condition, it is
possible to give access without hand recognition, but because this offers
reduced security, that should only be a last resort.
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Custom
Entries Screen

You only see this screen if have set up any custom user entries (see page 97).
The entries on this screen vary depending on what you have set up.  For
each entry on this screen, type the information in the Value column.

Click Finish when done.  

What to Do
Next

The next step is to enroll the user; see page 88.
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Adding a Group of Users at Once
You would add a group of users at once if you have to add many new users
with the same access profile and other security access options, and if you
want HandNet to automatically assign sequential ID numbers.  (If each
user needs a different access profile, if you need to assign non-sequential id
numbers, or if you want to fill in custom user entries while adding the users,
add single users instead; see Adding a Single New User on page 77.)

Beginning the
Process

To begin adding a new user, pick Add New... from the User menu.

Click the radio button by Add Multiple Users, and then click the Next
button.
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Adding Multiple Users

1. Click the User menu and then click Add New….  This takes you to the
first screen of the New User Wizard.

2. Click Add multiple new users, and then click Next.
3. On the screen that asks for the number of users and starting ID, enter

the number of users to create, and the ID number for the first new user.
Click Next to continue.

4. On the Security screen, choose the access profile to assign to each of the
new users.  If needed, you can change the authority level and limited
access.  Do NOT change the user reject threshold.  If you need to, you
can later change this individually for a user who is having access
problems.  Click Next to continue.

5. The next screen shows the progress in adding the users.  Once the
process is done, click Finish.

6. You need to enroll the users before they have access.  Typically, you will
also rename the users since adding multiple users at once uses the ID
number for the name.

7. If you have set up custom user entries, you will also want to edit the
Properties for each user, click the Custom tab, and fill the appropriate
information in there.
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Number of
Users to Add

and Starting ID

After you choose to add multiple users at once on the first screen of the New
User Wizard, you see this screen.

Number of users to create:  Enter the number of users you want to add.  

User ID to start with:  Enter the starting user ID number.  Use the number of
digits that you would like for the final id.  For example, if you always
want a five-digit ID number and you want to start with “1,” enter 00001
rather than just “1.”  If you enter 00001, HandNet will use 00002 next,
then 00003, and so on.  If HandNet finds that a number is already used,
if will skip that number and use the next available number.  For
example, if you enter 1000 as the starting number and 1000 through
1020 are all used, HandNet will automatically skip these numbers and
start at 1021.  When the program adds the numbers at the end of the
process, it lets you know if it had to skip any existing ID numbers.

However, don’t begin an ID with 0 (zero) if you are going to
enroll the user with the command menus on the reader.
HandNet lets you enroll a user by either picking Enroll from the Reader
menu, or by using the command menus on the reader.  If you are going
to use the command menus on the reader, the ID Number should not
begin with 0 (zero).  While HandNet distinguishes between 5 and 0005,
the process of adding a user from the reader command menu does not.
This means that if you create a user with an ID of 0005 in HandNet and
try to enroll that user with the command menus on the reader, when
you type 0005, the reader thinks you are enrolling user 5, and this won't
correspond with 0005 in HandNet.  If you are going to use Enroll on the
Reader menu, you can begin an ID with 0.  (If you are never going to
begin an ID with 0, this might be a good choice for a duress code if you
use one.  See page 47 for more about duress codes.)
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Security
Options

This screen controls what this user has access to and when.

After you click Next on this screen, HandNet adds the new users.

Select an access profile to control which readers the user can use at what times:
Click this entry for a list of available access profiles.  If these users can
use all readers at all times, choose Always.  If you don't want these
users to be able to use any readers at this point, choose Never.  For other
access, select the appropriate profile.  You must set access profiles up
before they are available here. See page 68 for more about setting up
access profiles.

Select an authority level to allow users to access reader commands:  This
determines what the users can do at the reader.  For most users, None
is the appropriate choice.

Each higher level gives access to the lower levels as well.  For example,
users with an authority level of 4 can also use the level 1, 2 and 3
menus.  Except for recalibrating the reader (part of level 1), and
enrolling a user if you haven't purchased the upgrade to the full feature
set, HandNet can control every setting in the reader, so there is
generally no need to control settings through the control menus in the
reader.

None: This lets the reader gain access through the reader, but not
use the command menus in the reader to change the reader's
settings.  This choice is appropriate for most users.

(1) Service: This lets you recalibrate the reader and change the
reader's status display.

(2) Setup: This lets you control reader setup issues including how
the reader is connected to your computer network, what
language the reader displays in, the date/time, etc.  

(3) Management: This lets you list users.
(4) Enrollment: This lets you add or remove users.
(5) Security:  This lets you control the passwords for the reader

menus, change time zones, enroll users who don't need hand
access, etc.

See the HandKey manual for more on directly changing settings
through the reader.
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Limited
Access

Enable limited access:  This gives a user access for a specific date range.  For
example, suppose a contractor or temporary employee was going to be
working in your building for a month.  Or suppose an employee gave
notice that he/she was leaving for a new job in two weeks.  Once this
period was over, you wouldn't want these users to have access.  Rather
than having to remember to disable the user on the appropriate date,
this option lets you set a start and end date/time so the user is
automatically enabled and disabled at the appropriate points.

To set up start and end date/times, check the box by this button and
then click the Edit Access button.  (This button only works if you have
checked the box.)  This takes you to the Edit Limited Access screen:

To change either start or end date or time, click the corresponding entry
and pick from the list that comes up.

This option is disabled if you haven't purchased the license upgrade to
the full feature set of version 2.0.

This option is NOT for limiting access to specific readers or for specific
times of the day; to control that, use the Access Profiles entry.

Override the reader's reject threshold (for users with special requirements):
Never change this option when adding multiple users at once.  For
users with a physical condition like arthritis that prevents them from
placing their hands on the reader in exactly the same way each time,
this option lets you control how exact the hand match must be for the
reader to grant access.  Only change this for individual users who are
having trouble gaining access, never for a whole group of users at once.

If you later discover that a user is having trouble getting access
consistently, go to the Security tab in the User Properties and change
this entry there; see page 93.  You would check this box and then slide
the pointer further to the right (the Less Sensitive side).  If a user has
a really severe hand condition, it is possible to give access without hand
recognition, but because this offers reduced security, that should only
be a last resort; see Adding a User Who Has Access Without Hand
Recognition on page 75 for more on this.
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Progress Bar This is the final screen in the process of adding new users.  If you are adding
a large number of users, it gives you an idea of how much longer the process
will take.

If HandNet tries to add ID numbers that are already used, you see messages
about those numbers being skipped.  (This won't change the number of new
users that are added.)

What to Do
Next

After you click Finish to leave the screen above, you need to enroll the users
before they have access; see page 88.  You’ll typically also want to rename
the users since this process uses the ID number for the name; page 90.  And
if you created custom user entries, you’ll want to go to the Custom tab in
User Properties to fill these entries in for each user; see page 94.
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Teaching Users How to Place Their Hands on Readers

Correct Hand
Placement

Because the reader is looking at the shape of the hand, it is important that
you place your hand on the reader the same way every time.  When you put
your hand on the reader, do this:

� If you are wearing a ring, make sure the stone is up in its normal posi-
tion.

� Slide your hand forward onto the platen (moving forward like a plane 
would land at the airport; not straight down like a helicopter would 
land).  Place your hand gently and comfortably; there’s no need to apply 
pressure.

� Keep your hand flat.  You should feel the platen with your palm and 
with the bottom of your fingers.

� Once you hand is flat on the platen, gently close your fingers so they 
touch against the finger pins.  Again, there is no need to apply pressure 
or press hard.  Watch the lights on the hand diagram on the top of the 
reader; if a light stays on, that finger isn't making proper contact with 
the pin.

Left Hand
Placement

If you have been enrolled with your left hand, follow the instructions above,
but put your left hand palm up on the reader.  The back of your hand should
be as flat as possible against the platen.
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Enrolling Users
Before a user can have access, you must take the user to a reader and have
the reader create an image or template of the user’s hand.  If you have
purchased the upgrade to the full feature set, you can start this process
using Enroll on the Reader menu.  If you haven't purchased this upgrade,
you must use the reader command menus to start the enrollment process.

Using the
Enroll Option

on the Reader
Menu

Before you enroll a user, add the user in HandNet; see page 77.  You should
also teach the user about correct hand placement; see page 87.

1. If the Network window isn’t open, press CTRL-N to open it.
2. In the Network window, click the reader to enroll the user at.
3. Click the Reader menu, and click

Enroll.  You see a screen like this:
4. If the user to enroll isn't shown, click

the entry and pick the user's name.
Then click Enroll now.

5. The reader asks the user to place
and remove his/her hand three times.  (If it asks for the hand more than
three times, the user isn't placing his/her hand consistently; go over the
instructions for correct hand placement.)

Unless you get a message indicating that there was a problem, the user is
now enrolled.

Manually
Enrolling

Users Using
the Reader
Command

Menus

Before you enroll a user, add the user in HandNet; see page 77.  You should
also teach the user about correct hand placement; page 87.

1. Check the list of users to make sure you have an Authority Level of 4
or higher.  If you have an authority level of None, 1, 2, or 3, you can't
do this.  (To change your authority level, double-click your name on
the list of users, click the Security tab, click the Authority Level entry,
and select the appropriate level.)

2. Go to the reader to be recalibrated, and enter command mode on the
reader:

If you have a HandKey II or HandKey CR reader:  Press CLEAR, and then
press ENTER.

If you have an ID3D HandKey reader:  Press # AND *.  (You can press
them at the same time, or one after the other.)

The display on the reader should look like this:

3. Type your User Id number (the same one you enter to get access
through the reader), and press ENTER or #.  The reader asks you to place
your hand.  Once it recognizes your hand, this display looks like this:

       READY      
*:

  ENTER PASSWORD
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4. Type 4 and press ENTER or #.  (This is the standard password for the
Enrollment menu in the reader; if you have changed this on the
Passwords screen in the Reader Properties, enter the password you
have set up.)

If you have a HandKey II or HandKey CR reader:  The display should
now look like this:

If you have an ID3D HandKey reader:  The display should now look like
this:

(If the reader shows the READY screen again instead of this screen, then
either you placed your hand improperly or you don't have the rights to
do this; carefully check step one again.)

5. Press the YES / # button.  This display should now look like this:

6. Type the ID Number of the user to enroll and press ENTER or YES / #.
The display should now look like this:

7. Have the user place his/her hand on the reader.  The reader will ask the
user to remove the hand and place it again.  The reader should ask the
user to place his/her hand three times; if it asks for the hand more than
three times, the user isn't placing his/her hand consistently; go over the
instructions for correct hand placement.

Once the user has correctly placed the hand three times, the reader
asks for the time zone:

8. When the user has access to this and other readers is controlled by the
access profile you have assigned in the user's properties, so just press
ENTER or YES / #.

9. The reader briefly flashes the message User Enrolled and then returns
you to the Add User or Enroll User display.  Enroll another user if
needed, or press the CLEAR button to leave the Enrollment menu and
return to the reader to its normal display.

�����

     ADD USER
  * NO    YES #

   ENROLL USER
  * NO    YES #

ID#?
:

** PLACE HAND **
  1/3

 ENTER TIME ZONE
 (0)?:
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Changing Users
Overview

Renaming
Users

1. If the user window isn't shown, press CTRL-U or pick Users from the
View menu.

2. Double-click the user to rename.  This takes you to User Properties.
3. Type the new name, and then press ENTER or click OK.

Alternate
methods

Right-click the user’s name and pick Rename from the menu that pops up;
click the user once and pick Rename from the View menu; or click the user
once, pause for long enough so the computer won't think you are double-
clicking, and then click directly on the user's name.

User
Properties,

General

The General tab in User Properties lets you change the user's name or ID.  It
also shows when the user last accessed a reader.

Name:  Enter the user's name.

If you want to sort the list of users by last name:  Enter the last name first.
For example, if the user's name were “Sam Gamgee,” you would
enter “Gamgee, Sam.”
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Changing Users

1. If the user window isn't shown, press CTRL-U or pick Users from the
View menu.

2. Double-click the user to change information for.  This takes you to the
General tab in the User Properties.  (You can also click the user once and
then pick Properties from the User menu.)

3. Click the tab that has the information you want to change
To change the user's name or ID:  This is on the General tab.
To change the users access level, authority, limited access, or the reader's

sensitivity:  Click the Security tab.
To change Custom entries:  Click the Custom tab.

4. Change information as needed and then click OK.
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If you have two users with the same name:  You must enter a unique name
for each user.  If two users have the same name, you might add a
middle initial, or you might add a job description after each.  For
example, if you had two users named John Jones, you might enter
something like Jones, John (engineer) and Jones, John
(maintenance).

ID Number:  If you change a user's ID, be sure to let the user know.  The user
won't be able to gain access through any reader without knowing the
correct ID.

Each number must be unique.  (If you could give the same number to
two users, the reader would not know which was trying to gain access.)
Longer numbers are slightly more secure, but four or five digits are
generally adequate in context where user's must enter the number.
You may enter up to ten digits if you don't use a duress code, or up to
nine digits if you do use a duress code.  If you use a duress code, make
sure that you don't create an ID that begins with that digit; see page 47
for more about duress codes.  If you have set up an ID length on the
Settings tab in the Reader Properties, make sure that you don't create
an ID that is longer than this; see page 47 for more about ID length.

If you use Wiegand card readers:  Enter the ID number stored on the card.

Don't begin an ID with 0 (zero) if you are going to enroll the user with the
command menus on the reader:  HandNet lets you enroll a user by
either picking Enroll from the Reader menu, or by using the
command menus on the reader.  If you are going to use the
command menus on the reader, the ID Number should not begin
with 0 (zero).  While HandNet distinguishes between 5 and 0005,
the process of adding a user from the reader doesn’t.  This means
that if you create a user with an ID of 0005 in HandNet and try to
enroll that user with the command menus on the reader, when you
type 0005, the reader thinks you are enrolling user 5; this won't
correspond with 0005 in HandNet.  If you are going to use Enroll on
the Reader menu, you can begin an ID with 0.  (If you are never
going to begin an ID with 0, this might be a good choice for a duress
code if you use one.)
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User
Properties,

Security

The Security tab controls what this user has access to and when.

Select an access profile to control which readers the user can use at what times:
Click this entry for a list of available access profiles.  If this user can use
all readers at all times, choose Always.  If you don't want the user to be
able to use any readers at this point, choose Never.  For other access,
select the appropriate profile.  You must set access profiles up before
they are available here. 

Select an authority level to allow users to access reader commands:  This
determines what the user can do at the reader.  For most users, None is
the appropriate choice.

Each higher level gives access to the lower levels as well.  For example,
a user with an authority level of 4 can also use the level 1, 2 and 3
menus.  Except for recalibrating the reader (part of level 1), and
enrolling a user if you haven't purchased the upgrade to the full feature
set, HandNet can control every setting in the reader, so there is
generally no need to control settings through the reader menus.

None: This lets the reader gain access through the reader, but not
use the command menus in the reader to change the reader's
settings.  This choice is appropriate for most users.

(1) Service: This lets you recalibrate the reader and change the
reader's status display.

(2) Setup: This lets you control reader setup issues including how
the reader is connected to your computer network, what
language the reader displays in, the date/time, etc.  

(3) Management: This lets you list users.
(4) Enrollment: This lets you add or remove users.
(5) Security:  This lets you control the passwords for the reader

menus, change time zones, enroll users who don't need hand
access, etc.

See the HandKey manual for more on directly changing settings
through the reader.
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Limited
Access

Enable limited access:  This gives a user access for a specific date range.  For
example, suppose a contractor or temporary employee was going to be
working in your building for a month.  Or suppose an employee gave
notice that he/she was leaving for a new job in two weeks.  Once this
period was over, you wouldn't want these users to have access.  Rather
than having to remember to disable the user on the appropriate date,
this option lets you set a start and end date/time so the user is
automatically enabled and disabled at the appropriate points.

To set up start and end date/times, check the box by this button and
then click the Edit Access button.  (This button only works if you have
checked the box.)  This takes you to the Edit Limited Access screen:

To change either start or end date or time, click the corresponding entry
and pick from the list that comes up.

This option is disabled if you haven't purchased the license upgrade to
the full feature set of version 2.0.

This option is NOT for limiting access to specific readers or for specific
times of the day.To control that, use the Access Profiles entry.

Override the reader's reject threshold (for users with special requirements):  For
users with a physical condition like arthritis that prevents them from
placing their hands on the reader in exactly the same way each time,
this option lets you control how exact the hand match must be for the
reader to grant access.  

If a user is having trouble getting access consistently, check this box
and then slide the pointer further to the right (the Less Sensitive side).
If a user has a really severe hand condition, it is possible to give access
without hand recognition, but because this offers reduced security, that
should only be a last resort.
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User
Properties,

Custom

You only see entries on the Custom tab if you have set up custom user
entries.  (See page 97 for more on creating custom user entries.)  The entries
on this screen vary depending on what you have set up; the entries on your
screen will probably be completely different from the examples show below.

To change a value, click the item in the Value column and then enter the
correct value.

When You Are
Done

When you are done changing User Properties, click the OK button at the
bottom of the screen.
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Changing Access for Many Users at Once
Import TZ

Option
Import TZ on the File menu lets you change the access profile to Always or
Never for many users based on information in a text file.  (This file would be
created with some other program.)

Caution If you use this option, be aware that there are security risks involved:  if you
mistype a number in the file, you could easily give full access to a different
user than you intended.  And unlike most other changes in HandNet, the
fact that this option was used and the fact that a user's access was changed
is NOT reflected in the activity log, so you won’t have any record of the
change.  In most contexts, it is more appropriate to change user access
through the Security tab in User Properties; see page 92.

File Format Each line of the file would list a user ID number followed by a comma, and
then either 0 (zero) to set that user's access profile to Always, or 61 to set
that user's profile to Never.  (Currently, you can't use the file to switch to
any other profile.)  For example, suppose your text file looked like this:
     1001, 0
     1002, 0
     1003, 61
     21345, 0
     43567, 61

If you imported this file, HandNet would set the access profile to Always for
users with the IDs of 1001, 1002, and 21345, and it would set the profile to
Never for users with IDs 1003 and 43567.  It wouldn't change the access
profiles for any other users.  If HandNet couldn't find a user with the
corresponding ID number, or if you had something other than 0 or 61 after
the comma, HandNet would skip that line.  It wouldn’t give you any
message or tell you the line was skipped.  If you had any lines that didn't
match the format above (for example, if you didn't have the comma between
the ID and the 0 or 61), HandNet would give a message at the end of the
process that told you how many bad records were ignored.  If other lines
were in the correct format, HandNet would still process them successfully.

You don't see any message or progress bar during the import process.  If you
are importing many records, you could have some delay where it looks like
nothing is happening.  For example, on a 166MHz processor, importing
1,000 records takes slightly over 30 seconds; you wouldn't see any activity
while this was happening.
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User Database Properties
What

Information Is
Shown

This screen shows general information about the whole user database,
including the date it was created, the version number, the number of
enrolled users and number of non-enrolled users, and the total number of
users in the database.  You don't typically need this information during
normal use of the program.  However, if you want to add or change custom
user entries, you would come to this screen and then click the Custom tab.

You get to this screen by picking DB Properties from the User menu.
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Adding Custom User Entries
To collect additional information about users in HandNet, you can add
additional custom entries.  HandNet then asks for this information on the
Custom screen of New User Wizard (see page 81) and the Custom tab in the
User Properties (page 94).

What you might want to collect could vary widely depending on how you are
using HandNet:  emergency phone numbers, employment start dates,
department, pager number.  You can add as many entries as you need.

The information that you add in custom entries is only available on the
screen, either in User Properties or on the list of users (available by picking
Users from the View menu).  Currently, HandNet doesn’t include custom
user information on any reports.

Getting to the
List of Custom

Entries

1. Click the User menu and then click
DB Properties.

2. Click the Custom tab.  You will see
a screen like this, but with different
entries.

Adding a New
Entry

To add a new custom entry, click the Add button.
You see this screen:

Type the name of the field or entry to add and press
ENTER or click OK.  Make sure that you enter the
name of the entry correctly; once you continue, you
can't change the name.

Deleting a
Custom Entry

Click the entry in the list and Delete.  Be sure that you are deleting the
correct item; the program won't ask you to confirm the deletion, and once
you delete a custom entry, all information that you have entered for users
in that entry is gone.  For example, suppose you created an “emergency
phone number” entry and entered phone numbers for all of your users.  If
you deleted emergency phone number here, all of the phone numbers that
you had entered would be gone and there would be no way to get them back
unless you had made a backup of your HandNet information.

Changing the
Order of the

Entries

On the Custom screen in the User Properties, the entries in the same order
as they are listed here.  To change the order of the entries, click the entry to
move and then click the up or down arrows next to the words Move field.
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Converting Users from MS-DOS HandNet or HandNet+
If you have been using one of our MS-DOS programs (either HandNet or
HandNet+), Convert HandNet+... on the File menu lets you import your
users so you don't have to enter and enroll them again.  This option brings
in each user's name, ID number, authority level, and reject threshold.

If you have been using an older version of HandNet for Windows, you don't
need to do anything to convert that information.

To Convert
HandNet Plus

Users

1. If you have been using HandNet rather than HandNet Plus, follow the
steps below to convert your user information from HandNet to
HandNet Plus format.  

2. Pick Convert HandNet+ from the File menu.
3. If you have installed HandNet+ somewhere other than in C:\HNET,

click the Browse button and go to the directory where HandNet+ is
installed. Then click the Open button.

4. Click the Convert button. The HandNet+ database is converted to
HandNet for Windows™ format.

5. This conversion does not bring in the access profiles for the users, so
when this is done you must assign an access profile to each user on the
Security tab in User Properties.

To Convert
MS-DOS

HandNet Users

If your DOS version of HandNet is in the standard /HNETdirectory:

Press F1 while in HandNet to pop up the help.  In the index, type
“convert” and open the topic on converting HandNet+ information.  In
this topic there is a button that automatically does this process for you.

If your DOS version of HandNet is NOT in the standard /HNET directory:

1. Copy the convert.exe file from the HandNet for Windows directory to
the directory the MS-DOS version of HandNet is in.  The standard
location for HandNet for Windows is C:\Program Files\Recognition
Systems, Inc.\HandNet for Windows.  For example, to copy the
convert file from this directory to c:\hnet, you would type:

copy c:\progra~1\recogn~1\handne~1\convert.exe c:\hnet\

2. Switch to the directory the MS-DOS version of HandNet is in.  For
example, to switch to the \hnet directory, you would type cd\hnet   and
press ENTER.

3. Make a backup copy of the file that contains your user information.
This file is called id_dbase.dat.  For example, you might type:

copy id_dbase.dat id_dabase.bak

4. Type convert  and press ENTER.  This should convert the information to
HandNet Plus format.  Once you have done this, you are ready to import
the information into HandNet for Windows using the steps described
above.

�����



Adding and Maintaining Users   •   Importing and Exporting Users 99

Importing and Exporting Users

Getting User
Information

from a Reader

If you've already set up users in a reader that you are connecting to
HandNet, you don't need to recreate those users.  You can get user
information from the reader by doing this:

1. Pick Network from the View menu (or type CTRL-N).
2. On the list of readers in the right pane of the Network window, select

the reader(s) to get user information from.
3. Click the Reader menu, click Upload, and click Users.
4. The program asks you to confirm that you want to upload users from

the reader; click Yes to continue.

Importing
Users from

Another Copy
of HandNet

You only need to import users if you have readers connected to several
different computers (each with its own copy of HandNet) and if users added
to one system need to be available on the others.  If all of your readers are
connected to a single copy of HandNet, you don't need this feature.

The export feature is only available if you have purchased the upgrade to
the full feature set of version 2.0.

Setting up
import

settings first

Make sure that you select the correct choices for what to import on the User
Import/Export tab in System Settings before you try to import; see page 29.
When HandNet imports, it empties the import file, discarding those user
records that don't meet the conditions you have checked there.

Importing
users from

another
computer

1. On the computer where you exported users, go to the HandNet
directory and copy the file export.mdb to a floppy disk.  (You could also
copy this file to a network drive, attach it to an e-mail, etc.)

2. Rename the file on the disk (or in the new location) to import.mdb.
3. Put this import.mdb file into the HandNet directory on the computer

where you want to import users.
4. If you don't have that copy of HandNet set up to import automatically,

pick Import Users from the File menu.  (If you have the Enable box
under Auto Import checked on the User Import/Export tab in System
Settings, HandNet starts importing as soon as it finds the import.mdb
file in the directory; see page 29.)

The activity window lists each user that is added, deleted or changed.
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Exporting
Users to

Another Copy
of HandNet

You only need to export users if you have readers connected to several
different computers (each with its own copy of HandNet) and if users added
to one system need to be available on the others.  If all of your readers are
connected to a single copy of HandNet, you don't need this feature.

The export feature is only available if you have purchased the upgrade to
the full feature set of version 2.0.

Automatically
exporting

users

HandNet can automatically export users when you create, enroll, change or
delete users.  When HandNet exports users is controlled by the items in the
Export column on the User Import/Export tab in System Settings; see
page 30.

Manually
exporting

users

1. Go to the Users window.
2. Select the users to export.  To select multiple users that are together on

the list, click the first user, hold the SHIFT key down, and with the SHIFT
key down, click the last user that you want to select.  To select multiple
users that are not together on the list, click the first user to select, hold
the CTRL key down, and with the CTRL key down, click each other user
that you want to select.

3. Right-click.  (This brings up a menu.)
4. On the menu, point to Export, and then pick Selected.  (Or pick All to

export every user in the list whether selected or not.)

You will see a message with a progress bar that indicates that the users are
being exported.  (If you only selected a few users, this may vanish almost
instantly.)  Once this box disappears, the export process is done.

To import these users on the other computer, see the instructions for
Importing Users from Another Copy of HandNet on page 99.
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Monitoring Ongoing Activity

Activity Window 
The Activity window lists everything that happens at any reader connected
to HandNet, and any change made in the HandNet program.  To open this
window, pick Activity from the View menu or press CTRL-A.

Only the first two tabs at the bottom of this screen (Activity and Alarms) are
always there.  The others are merely examples of custom activity views that
you can create as needed; see Creating a Custom Activity View on page 104.

Rearranging or
Resizing

Columns in the
Activity
Window

To move any column, click on the column heading and hold the mouse down.
With the mouse held down, drag the column heading to the left or right.

Getting More
Detail about a
Activity in the

Activity
Window

When you double-click on an activity
in the Activity window, you get a
screen like this that tells more about
that activity.

Date/Time:  This shows the date and
time when the activity occurred.
The date is listed in month/day/
year order, and the time lists
hours/minutes/seconds.

Site:  If this activity happened at a
reader, this shows the name of the
site the reader is associated with.

Reader:  If this activity happened at a
reader, this shows the reader's
name.

Address:  If this activity happened at a reader, this shows the reader's
address; this address should correspond with the name of the reader
listed above.  If this activity occurred in the HandNet program, this
says 255.
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Message Explanation:  This shows some additional explanation of the
message.  For more explanation, see the complete list of activity
messages starting on Activity Messages on page 118.

Type:  Each message falls into one of ten categories.  When you are creating
an activity filter or custom activity report, you can limit your report or
activity view to specific types of messages.  See Message Types on
page 113 for more detail.

Message:  This shows the same message that you saw on the list in the
Activity window.

User/Info:  If this message is associated with a particular user, this shows the
user's name and ID number.  

Data:  This shows technical detail about the message that isn't relevant to
your use of the program.  This is occasionally useful to support in
debugging a problem.

Acknowledged [checkbox]:  This shows whether this message has been
acknowledged yet.  You can't uncheck this box once it is marked.  You
also can check the box directly; you must use one of the three
Acknowledge... buttons below.

Buttons on
the Activity

Details
screen

Acknowledge This Message:  This marks the message as acknowledged.  After
the message on the activity or alarm list, you will see :ACK followed by
the name of the operator who acknowledged the message and the date/
time when it was acknowledged.  If this is an alarm, this also shuts the
alarm off.  

Acknowledge & Show Next:  This acknowledges the current message and
shows the next message.  By next, we mean more recent in time; that is,
the message above the current message on the activity list.

Acknowledge All Alarms:  This button is disabled unless there is an alarm
that hasn't been acknowledged yet.  You might use this button if you see
several related alarms on the list and you want to acknowledge them all
at once.

More Info:  This brings up the on-line help.

Next:  This shows the message that occurred more recently in time, that is,
the message directly before this on the activity list.

Previous:  This shows the message that occurred before this message in
time, that is, the message directly after it on the activity list.
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Getting to and Acknowledging Alarms

Getting to the
Alarms List

Alarms are listed with the rest of the activity in the Activity window, but
we've also provide a separate view with just the alarms.  To see this view,
click the Alarms tab at the bottom of the Activity window.

Acknowledgin
g an Alarm

If an alarm is triggered in HandNet, do this to acknowledge it and turn it off.

1. If the Activity window isn't shown, press CTRL-A or pick Activity from
the View menu.

2. Double-click the alarm message with the bell icon next to it.  (You can
see it both in the regular activity view or by clicking the Alarm tab at
the bottom of the window.)

3. Click one of the Acknowledge... buttons at the bottom left of the window.
(You can't just click the checkbox by the word acknowledged; you must
click one of the buttons.)  After the message on the activity or alarm list,
you will now see :ACK followed by the name of the operator who
acknowledged the message and the date/time it was acknowledged.

4. Take whatever action is appropriate in response to the alarm.

What
Situations

Cause Alarms

Which situations trigger alarms depends on which items are checked on the
Alarms tab in the System Settings; see page 25.
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Creating and Printing Custom Activity Views
Creating a

Custom
Activity View

The main Activity window lists all activity that occurs:  every access from
every reader, every failed access, every user addition and enrollment, every
alarm, and so on.  Sometimes it's useful to see less than this.  For example,
if you wanted to identify users who were having access problems, you might
want to see only the Identity Unknown and Access Denied messages (the
messages that can occur when someone enters a valid ID but then doesn't
get a match on the hand).  Or if you wanted to identify who had come in the
building, you might want to see only Identity Verified messages and only for
the readers that controlled entrances to the building.  

You can create (and print reports on) custom views for these or any other
subsets of activity, limiting the view to specific messages, dates, times,
users, and/or readers.  To create a custom activity view:

1. Click the View menu, and click
Activity Filter.  You see a list of any
custom activity views if you have
created any yet.  This list looks like
this, but the “filters” listed will be
different.

2. Click the Add button to create a new
filter (that is, a set of conditions that
will filter out only the information you want to see).  This takes you to
the first Activity Filter screen.  (To change a filter you've already
created, click the filter and then click Edit.)

3. Give the filter a name, associate an icon if you wish, and then go to each
tab where you want to include something less than all of the activity.

Each tab is initially set up to include all information; go to those where
you want to limit or filter out particular information.  For example, if
you only wanted activity at certain readers, you would go to the Readers
tab.  If you only want certain messages, go to the Messages tab.  The
options on these tabs are explained starting on page 107.

4. When you have entered all of the conditions needed, click the OK button
at the bottom of the window.

To start this process, you could also right click on the bar at the bottom of
the Activity window, and then pick Add New Filter....

Removing a
Custom

Activity View

This doesn’t remove any activity from HandNet; it only removes the custom
view of the activity.

1. Click the View menu, and click Activity Filter.  You will see a list of
any custom activity views you have created.

2. Click the view or filter to remove and click Delete.
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Printing an
Activity Report

Based on an
Activity
Window

1. Right-click on the bottom bar of the Activity window (where the
Activity and Alarms tabs are).

2. Pick Generate Report.
3. In the report window that comes up, click the printer icon in the header;

see Printing or Viewing Reports on page 129 for more detail.

Creating a
Custom

Activity Report
from the

Reports Menu

If you haven't already created a custom activity view, or if you need to run
the report on archived activity, then follow these steps to design the report.

1. From the main menu bar, click
File, click Reports, and click
Activity....  You see a screen like
this.  (If you had created any
custom reports they would be
listed; your reports may be very
different from the samples
listed here.)

2. Click the Add button to create a
report (that is, a set of conditions
that will filter out only the
information you want to see).  This takes you to the first Activity Report
screen.  (To change a report you've already created, click the filter and
then click Edit.)  The screens that you see are identical to those that you
see when creating a custom activity view.

3. Give the report a name, associate an icon if you wish, and then go to
each tab where you want to include something less than all of the
activity.

Each tab is initially set up to include all information; go to those where
you want to limit or filter out particular information.  For example, if
you only wanted activity at certain readers, you would go to the Readers
tab.  If you only want certain messages, go to the Messages tab.  The
options on these tabs are explained starting on page 107.

4. When you have entered all of the conditions needed, click the OK button
at the bottom of the window.  This returns you to the list of reports.

Printing an
Activity Report

from the
Reports Menu

1. From the main menu, click File,
click Reports, and then click
Activity Reports.  You see a
screen like this.  (If you’ve
created any custom reports they
would be listed; your reports
may be very different from the
samples listed here.)

2. If you haven't already designed
the report, see Creating a
Custom Activity Report from the
Reports Menu on page 105 for help designing it.
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3. Click the report in the list of reports at the top of the window.
4. At the bottom of the window, indicate which activity to generate the

report from:

The system activity log:  This includes all the activity that has occurred
since the last time you archived activity (and that meets your
report conditions).

An activity archive:  This includes all activity that meets your report
conditions that is in the archive file that you pick.  Click the radio
button by this choice, click the browse button, and pick the file.
HandNet list files that have an .hna extension.  Pick the archive
file and click OK.

If the activity that you want is in several archive files,  you will
have to run the report several times, once for each archive file.  If
you need the information in a single report, you can export each
report to a file and then use another program to combine the
reports into a single file.

5. Click the Generate Report button.  HandNet generates the report and
shows it in a new window on the screen.

6. Click the printer icon near the middle of the header to print the report,
or click the icon with the envelope to export the content of the report to
a file.  You can export to a variety of formats including Word, Excel,
Lotus 1-2-3, rtf, text, and others.  See Printing or Viewing Reports on
page 129 for more detail.

If the printer icon is disabled and grayed-out, you don’t have a printer
set up yet on this computer.  (To set up a printer, go to the Windows
Start menu, highlight Settings, pick Printers, and click Add Printer.)

7. To close the report window when done, click the X in the upper-right
corner of the window.

�����



Monitoring Ongoing Activity   •   Condition Screens for Creating Custom Activity Views/Reports 107

Condition Screens for Creating Custom Activity Views/Reports
When you create an activity filter (that is, a custom view of your activity; see
page 104), or when you design a custom activity report (see page 105), you
see the screen shown below.

Each tab is initially set up to include all information; you only need to go to
those tabs where you want to limit or filter out particular information.  For
example, if you only wanted activity at certain readers, you would go to the
Readers tab.  If you only wanted certain messages, you would go to the
Messages tab.

General This screen contains the name and icon associated with activity filter or
report.

Name:  Enter a name that describes the conditions that determine what
activity will be included.

Icon:  If you want an icon associated with the this activity view/report, click
the this entry.  You don't have to choose an icon if you don't want to.  If
you don't want an icon, don't pick an icon; once you pick one, you can't
go back to having no icon.

Don’t click OK until you have gone to the other tabs and set up those
conditions that limit the activity.
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Date This screen lets you limit the activity you see to certain dates.

On any date:  This includes activity from any date that is in the activity file.
This is always the initial choice when you create a new report or activity
filter.

Between:  This includes any activity between the dates entered or on those
dates.  For example, if you chose Between 05/01/01 and 05/31/01,
activity from both 05/01 and 05/31 would be included along with the
activity in between.

After:  This includes activity that is after the date that you enter, but not
activity that is on or before that date.  For example, if you entered 05/
01/01, you would see activity from 05/02 on, but activity on 05/01 would
not be included.  (If you wanted the activity from 05/01, you would have
to enter After 04/30.)

Before:  This includes activity that is before the date that you enter, but not
activity that is on or after that date.  For example, if you entered 04/30/
01, you would see activity from 04/29 and before, but activity from 04/
30 would not be included.  (If you wanted the activity from 04/30, you
would have to enter Before 05/01.)

During the past:  This is useful for creating a view that lists only the most
recent activity.  For example, you might create a view  that only listed
activity during the past week.  If you want to be more precise, this same
option is on the Time screen so that you could, for example, limit a view
to the last 24 hours.
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Time This screen controls what times activity must occur to be included.

On any time:  This includes activity from any time.  This is always the initial
choice when you create a new report or activity filter.

Between:  This includes any activity between the times entered or exactly at
those times.  For example, if you chose Between 12:00 and 13:00,
activity that happened at exactly 12:00 or 1:00 PM along with the
activity in between would be included.  This goes from the earliest time
to the latest time, regardless of which you enter first.  For example, if
you enter Between 17:00 and 8:00 (hoping to get activity that was not
during normal business hours), you would get the same activity as if
you had entered Between 8:00 and 17:00 (that is, activity that occurred
during normal business hours).  If you really want activity that is after
5:00 PM and before 8:00 AM, you would have to create two filters:  one
looking for activity after 17:00 and the other looking for activity before
8:00.

After:  This includes activity that is after the time that you enter, but not
activity that is exactly at that time.  For example, if you entered 12:00,
you would see activity from 12:00:01 (that is one second after 12) on, but
activity at 12:00:00 or before would not be included.

Before:  This includes activity that is before the time that you enter, but not
activity that is exactly at that time.  For example, if you entered 12:00,
you would see activity from 11:59:59 (that is one second before 12:00)
on, but activity at 12:00:00 or after would not be included.

During the past:  This is useful for creating a view that lists only the most
recent activity.  For example, you might create a view  that only listed
activity during the past 24 or 48 hours.  (For longer periods, this same
option is on the Date screen so that you could, for example, limit a view
to the past 30 days.)



Monitoring Ongoing Activity   •   Condition Screens for Creating Custom Activity Views/Reports 110

Sites This screen lets you limit the activity to certain sites.

Any site:  Leave this selected to not limit the activity based on site.

A site named:  This option is permanently disabled.  To get activity for a
single site, use the following option and only click one site in the list.

The sites selected below:  To limit the report/view to specific sites, click this
and then select the sites to include activity from.

To select a single site:  Click that site in the list.
To select multiple sites that are together on the list:  Click the first site

in the group, hold the SHIFT key down, and with the SHIFT key
down, click the last site that you want to select.

To select multiple sites that are not together on the list:  Click the first
site to select, hold the CTRL key down, and with the CTRL key
down, click each other site that you want to select.

If you select specific sites here, make sure you don't select readers from
different sites on the Reader tab; if you select sites here and select
readers from different sites, you won't see any activity with this filter.
If you want to select specific readers, select Any site on this screen.
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Readers This tab lets you limit to activity that occurred at certain readers.  For
example, you might want to limit activity only to the readers controlling the
entrances to the building so you could see who has come in.  Or you might
want to limit activity to the readers controlling the most secure areas so you
could monitor them more closely.

Any reader:  Leave this selected to not limit the activity based on site.

A reader named:  This option is permanently disabled.  To get activity for a
single reader, use the following option and select only that one reader
in the list.

The readers selected below:  To limit the report/view to specific readers, click
this and then select the readers to include activity from.

To select a single reader:  Click that reader in the list.
To select multiple readers that are together on the list:  Click the first

reader in the group, hold the SHIFT key down, and with the
SHIFT key down, click the last reader that you want to select.

To select multiple readers that are not together on the list:  Click the
first reader to select, hold the CTRL key down, and with the
CTRL key down, click each other reader that you want to select.
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Users This screen lets you limit to activity that occurred for certain users.

Any user:  Leave this selected to not limit the activity to particular users.

A user named:  This option is permanently disabled.  For a single user, use
the following option and select only that one user in the list.

The readers selected below:  To limit the report/view to specific users, click
this and then select the users to include activity for.

To select a single user:  Click that user in the list.
To select multiple users that are together on the list:  Click the first user

in the group, hold the SHIFT key down, and with the SHIFT key
down, click the last user that you want to select.

To select multiple users that are not together on the list:  Click the first user to
select, hold the CTRL key down, and with the CTRL key down, click each
other user that you want to select.
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Message
Types

This screen lets you limit the activity included to particular kinds of
messages.  If you need only specific messages within a category, use the
Messages tab instead.

Any message:  This includes activity regardless of what type of message it
generated.

The messages types checked below:  Click this and then check any message
type to include.  You can check more than one box to include multiple
types of messages.

Acknowledgement:  This doesn't list anything.
Alarm:  This lists any message that generates an alarm.  Which

messages generate alarms is controlled by your choices on the
Alarms tab in System Settings.  If you change which messages
generate alarms, messages that didn't generate an alarm
when they occurred won't be listed, even if they would generate
an alarm now.

Invalid Access Attempt:  This lists any message where someone tried
to get access and couldn't.  This includes the messages Identity
Unknown, Access Denied, and Access Refused, Time Zone.

Operator Logs:  This lists when operators logged in or logged out of
HandNet, and it lists invalid login attempts.  It doesn't list the
addition of new operators or changes to the operator settings;
only when each operator used the system.

Setup Changed:  This lists any setup changes made directly using
command mode at the reader.  For setup changes made
through HandNet, use System Database.

Status:  This lists any messages that tell whether auxiliary input
and output is on or off.

System Database:  This lists all setting changes made through
HandNet.  This includes adding or changing sites and readers,
changing System Settings, changing time zones, holidays and
access profiles.

System Status:  This lists messages related to when HandNet was
started and exited, messages related to enrolling users,



Monitoring Ongoing Activity   •   Condition Screens for Creating Custom Activity Views/Reports 114

messages related to communication problems with readers,
and messages related to information being downloaded/
uploaded to/from readers.

User Database:  This lists messages related to users being added,
deleted, or changed.  It does not include messages related to
users being enrolled or attempted unauthorized enrollments.

Valid Access:  This lists Identity Verified messages.

Messages This screen lets you limit the report or activity view to specific messages.
For example, if you were trying to track who came into the building, you
might select the building entrances on the readers tab, and then choose only
the message Identity Verified here.  Or if you were trying to track access
problems, you might limit the output to the messages Access Denied or
Identity Unknown.  If you want all of the messages in a particular category,
you may find it easier to use the Message Types tab instead.

Any message:  This includes activity regardless of what message it
generated.

The messages checked below:  Check any message to include.  See the list of
activity messages starting on page 118 for an explanation of what
causes each message.  Not all of the messages include what you would
expect.  For example, the message Authority Level Changed does not
include users whose authority level was changed on the Security screen
in User Properties; it only includes users whose authority level was
changed using the command menus on a reader, which is not how you
would typically change a user if you use HandNet.  Many of the
messages are like this.  If you want all of the messages in a particular
category, you may find it easier to use the Message Types tab instead.

�����
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Archiving Past Activity
What

Archiving Is
Archiving is moving past activity from the current activity file to a separate
file.  This keeps the activity file smaller (and faster) while still keeping the
information available for reports if needed.  You can set HandNet to remind
you to make archives using the Archives tab in the System Settings; see
page 26.

To generate an activity report on activity that is archived, you must indicate
that you want to generate the report based on an activity archive (and then
pick the appropriate archive).

Effect of
Archiving on

Reports

When you archive, HandNet removes activity from the current activity file
and stores it in a different file.  When you generate an activity report, you
can use the current activity file OR one of your archive files, but you can’t
include activity from more than one file in a single report.  This means, for
example, that if you make an archive once a month, you can’t generate a
single report that looks at the previous year’s activity; you would have to
generate 12 reports, one for each monthly archive file.  If you want an entire
year’s information in a single report, don’t archive until the year is done, so
all activity for the year will be in a single file.

Making the
Archive

To make an archive of past activity, click the File menu and then click
Archive.  You see a screen like this:

Available activity:  This shows the date of the earliest activity in the activity
file and the date of the most recent activity (usually today's date).  One
the right you will see the total number of events or activities currently
in the file.

Selected for archival:  This lets you choose the date range to include in the
archive.  The From date is initially set to the date of the earliest activity
in the file; you don't normally want to change this date.  The To date is
initially set to today's date; you might sometimes want to make this
earlier to keep more activity in the file.  For example, suppose you make
an archive on the 5th of each month for the previous month.  You could
change the To date to the last day of the previous month so that activity
from the beginning of the current month wouldn't be archived yet.
Even if you leave the To date set to the current date, HandNet may not
actually go up to that date:  on the Archives tab in the System Settings
there is an entry Do not archive the latest ___ events.  The archive
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process keeps at least that many events in the current activity file, even
if some of those events are before the date you enter here.

Estimated size of archive file:  This is the approximate size that the archive
file will be.

Archive file:  This lists the name and location of the file that will be created.
HandNet uses the location that you have entered for the Default
Archive Directory on the Archives tab in the System Settings; see
page 27.  HandNet names the file using year/month/day hour/minute/
seconds.  For example HN Activity Archive 20010406 094542.hna is the
default name for a file made on April 6, 2001 at 9:45 (and 42 seconds)
AM.  If you sometimes need to generate reports on past activity and you
don't find this naming method very clear, you can change this name.
For example, if the archive contained information from the previous
month, you might name it something like Archive March, 2001.hna.
You must keep the .hna extension for HandNet to be able to find the file
when you want to generate a report on it.

Once all entries are correct, click the Archive button to make the archive.

�����
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Exporting Activity
Why Export

Activity
If you want to create custom activity reports using some external report
tool, Export Activity on the File menu sends all of your current activity to an
Access database file called expactvt.mdb.  While the main HandNet
database files are password protected for security reasons, this file is not, so
you can open it (if you have Microsoft Access) and use any information in it.
If you're only going to generate reports with Activity Reports on the File
menu, you don't need this option; using it would only create a file that you
don't need.

This option only exports current activity, not activity that you have
archived, so if you plan to use this option, you probably should check the
Export Transactions box on the Archive tab in System settings; see page 27.
This causes activity to be automatically exported whenever you archive
activity.

You only have access to this option if you have purchased the upgrade to full
feature set of version 2.0.

When you choose Export Activity, HandNet pops up a box that tells you how
many activity records are going to be exported.  Click OK to continue.

Avoiding
Exporting the

Same
Information

Twice

If you export activity and then export activity again without
having archived the activity you exported last time, you will end up
with duplicate records in that export file.  That is, you will find the
same activities listed more than once. 

To avoid duplicate activity in the export file you can do one of two things.

� You can export activity and then immediately archive ALL activity.  
That way, the next time you export activity, the activity that was 
exported last time won't be in the current activity file, so it won't be 
exported again.

� If you don't want to archive activity after exporting (you might want to 
keep more activity in the current activity file so that you could see it in 
custom activity views or create reports that included a longer range of 
activity), delete or rename the last activity export file (expactvt.mdb) 
before exporting again.  If you delete or rename this file, HandNet cre-
ates a new expactvt.mdb file when you export, and this new file will 
only contain the information from this export and not what you 
exported last time.

�����
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Activity Messages
You see activity messages in the Activity window.  You can limit the activity
in a custom activity view or in an activity report by checking the
corresponding messages on the Messages tab in the filter/report design (see
page 114).  And you can control which messages cause alarms using the
Alarms tab in the System Settings (see page 25).

We have explained the messages in more detail here.

Command
Menus in the

Reader

Readers have built-in menus that let you change the settings in the reader.
Some of the messages below can only occur if you make changes through
these menus on the actual readers; you shouldn’t typically see these
messages.  Except for initially setting up the reader to communicate with
HandNet, for recalibrating the reader, and for enrolling a user from the
reader, you should NOT make changes to the reader through the reader
command menus; you should control all other reader settings from within
HandNet.  See the HandKey manual for more about the reader menus.

Activity
messages

Access Denied: Someone repeatedly entered a valid ID at a reader, and each
time the reader did NOT recognize the user's hand. (At the reader, the
user will see the message ID Refused.) The number of times that a user
can try before getting this message depends on the Number of Tries
entry on the Settings tab in the Reader Properties; see page 47. If access
is denied for a user, the reader will not accept that ID again until
another user has successfully gained access at that reader.

Access Profiles Changed: Someone changed one or more access profiles.
During initial setup, this is a normal message. If you weren't expecting
access profiles to change, this could be an indication that someone was
trying to give inappropriate access.

Access Refused, Time Zone: A valid ID was entered at a reader, but the user
isn't authorized to have access during the hours or days of the week
based on the time zone associated with the reader in the access profile. 

Activated Limited Access User: A user was set up with access for a limited
date/time range. The computer's date and time matched the date/time
the user was scheduled to start having access, so HandNet made the
user active and sent the user's information to each appropriate reader
so the user could can access.  See page 93 for more about limited access.

Activity Archived: The operator used the Archive option on the File menu.
(See page 115 for more on archiving past activity.)

Alarm Acknowledged: An alarm occurred, and an operator went to the Alarm
Properties screen and clicked one of the acknowledge buttons.
(Following the message on the activity or alarm list, you will see :ACK
followed by the name of the operator who acknowledged the alarm and
when it was acknowledged.)  See page 103 for more on acknowledging
alarms.

Amnesty Punch Granted: You shouldn't see this message.
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Authority Level Changed: A user's authority level was changed from the
reader's command menu. (Typically you would change a user's
authority level from the Security tab in the User Properties; if you
change the authority level there, you just see the message User Record
Changed.)

Auto Import Started: An import.mdb file (which contains users to import) was
found, and HandNet was set up to automatically import users, so
HandNet started importing them.  Whether HandNet automatically
imports users is controlled by the Enable box under Auto Import on the
User Import/Export tab in System Settings; see page 29.

Aux Output OFF: The auxiliary output has been turned off.

Aux Unlock Via Wiegand Keypad: The auxiliary output has been turned on by
a valid ID number at a remote keypad.

Auxiliary Input ON: The auxiliary input on the reader has been activated.

Auxiliary Output ON: The reader has turned on an auxiliary device (like an
alarm) that is connected to the reader.

Auxiliary Output Setup Changed: The timing and clearing of an auxiliary
output activation has been changed.

Baud Rate Changed: The communications baud rate has been changed using
the command menus at the reader.

Command Mode Entered:  Someone entered the command mode at a reader.
Readers have built in menus that let you change the reader settings.
These command menus are mainly needed when someone is using the
readers without the HandNet program; HandNet controls most
settings in the reader for you. The only tasks you should need to do
through the reader command menus are setting up the reader's address
and communication settings during initial setup, recalibrating the
reader, and enrolling users at the reader if you aren't using the Enroll
option on the Reader menu. 

Data Base Restored: You shouldn't see this message.

Data Base Saved: You shouldn't see this message.

Data Downloaded to Reader: Someone used one of the Download options on
the Reader menu to send information to the reader; see page 61.
(Unless there was some problem with the reader that is being corrected,
this isn't usually necessary; HandNet usually automatically sends all
information to the reader that the reader needs.)

Data Log Buffer Empty: You shouldn't see this message.

Deactivating Limited Access User: A user was set up with access for a limited
date/time range. The computer's date and time matched the date/time
the user's access was supposed to end, so HandNet made the user
inactive and sent the appropriate information to readers so the user
could no longer gain access.  See page 93 for more about limited access.
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Door Forced Open: A door was forced open without a valid ID and hand
recognition at a reader.

Door Open Too Long: A door was kept open for longer than was allowed based
on the time entered in the Door Switch Shunt Time on the
Configuration tab in the Reader Properties; see page 48.

Duress Alarm: A user entered the duress code, a code that indicates that the
user is in trouble or that someone is forcing the user to give him/her
access.  See page 47 for more about duress codes.

Exit Granted: The user is permitted to exit.

Extended Datalog: Someone entered command mode on the reader and
changed settings that don't have specific messages associated with
them. (For example, you get this message if you change the language of
the reader's display or the format of the date on the reader.)

HandNet Exited: Someone picked Exit from the File menu to shut HandNet
down. Under normal circumstances, HandNet is left running
continually so it can monitor activity and immediately process any
alarm messages. If someone exited HandNet to install a new version of
the program or to perform maintenance on the computer it is on, there
is probably no problem; if someone exited the program at some other
point, this could be an indication of an attempt to get around security. 

HandNet Started: Someone started the HandNet program. Under normal
circumstances, HandNet is usually left running continually so it can
monitor activity and immediately process any alarm messages. If
someone exited HandNet to install a new version of the program or to
perform maintenance on the computer it is on and then restarted, then
there is probably no problem. If you see the message HandNet Started
but you don't see the message HandNet Exited earlier in the list, then
someone exited the program and restored an older version of the
activity files; this could be an indication that someone is trying to hide
activity.

HandNet+ File Converted: Someone used Convert HandNet+ on the File menu
to convert users from HandNet+ into HandNet for Windows.
(HandNet+ was an MS-DOS predecessor to HandNet for Windows.)
See page 98 for more on converting users from MS-DOS versions of
HandNet.

Holiday Table Changed: Someone has added, changed, or deleted a holiday
with the Holidays option.  See page 66 for more about setting up
holidays.

Identity Unknown: Someone entered a valid ID at a reader, but the reader did
not recognize the user's hand.

Identity Verified: At a reader, a user entered a valid ID and the reader
recognized the user's hand and gave access.

Invalid Operator Login Attempt: Someone tried to log into HandNet but
entered an invalid user name or password. This could occur if someone
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just typed the name or password incorrectly, or it could mean that an
unauthorized person was trying to get into the program.

Leave Command Mode: Someone exited or left command mode at a reader.
Readers have built in menus that let you change the reader settings.
These command menus are mainly needed when someone is using the
readers without the HandNet program; HandNet controls most
settings in the reader for you. The only tasks you should need to do
through the reader command menus are setting up the reader's address
and communication settings during initial setup, recalibrating the
reader, and enrolling users at the reader if you aren't using the enroll
option on the Reader menu. 

Lock Output OFF: Someone chose Relock from the Reader menu to relock an
unlocked door.  See page 130 for more about locking and unlocking
doors.

Lock Output ON: Someone chose to unlock a door using one of the Unlock
options on the Reader menu.  See page 130 for more about locking and
unlocking doors.

Lock Setup Changed: Using the command menus in the reader, someone
changed the number of seconds the lock should be unlocked for or the
number of seconds the door is allowed to be open. (Normally this is
changed in HandNet on the Configuration tab in Reader Properties; if it
is changed there, you just see the message Reader Properties Changed.)

Manual Import Started: The operator selected Import Users to import users
from the import.mdb file.  See page 99 for more about importing users.
(When you must import users manually or whether HandNet imports
them automatically is controlled by the Enable box under Auto Import
on the User Import/Export tab in System Settings; see page 28.)

Maximum ID Length Changed: Someone changed the maximum length for a
user ID using the command menus in the reader. (If you changed the ID
length on the Settings tab in the Reader Properties, you would just see
the message Reader Properties Changed.)

Memory Cleared: Someone used the clear memory option from the command
menus in the reader. This erases all the users from the reader.
(Typically you would do this if you were changing the use of the reader
and wanted to make sure that those who previously had access through
this reader no longer had access through it.)

Messages Read: You shouldn't see this message.

No Hand Read For Card: You shouldn't see this message.

Operating Mode Changed: The operating mode of the reader has been
changed using the command menus in the reader.

Operator Added: A new operator (someone authorized to use HandNet) was
added on the Operators tab in System Settings.  See page 24 for more
about adding operators.
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Operator Deleted: An operator (someone authorized to use HandNet) was
removed from the Operators tab in System Settings.  See page 24 for
more about deleting operators.

Operator Login: An operator logged into HandNet.

Operator Logout: An operator logged out of HandNet.

Operator Properties Changed: Someone changed the tasks that an operator is
allowed to do on the Operators tab in System Settings.  See page 24 for
more about controlling which options an operator can use.

Output Mode Changed: The output mode of lock output or card reader
emulation has been changed using the command menus in the reader.

Passwords Changed: Someone changed the passwords for the reader
command menus using the command menus in the reader. Generally
this setting is controlled from HandNet on the Passwords tab in Reader
Properties rather than from the reader. (If you change this or other
settings for the reader in HandNet, you just see the message Reader
Properties Changed.)

Printer Setup Changed: If a serial printer is attached to the reader, the
printer settings have been changed using the command menus in the
reader.

Reader Action Failed: HandNet was unable to complete a communication
attempt with the reader.  This could be an indication that the
connection to the reader isn't set up correctly; see the troubleshooting
for help resolving this error.

Reader Added: A reader was added to HandNet.

Reader Connection Failed: HandNet was not able to establish
communications with the reader.  This could be an indication that the
connection to the reader isn't set up correctly; see the troubleshooting
for help resolving this error.

Reader Connection Timeout: HandNet lost its connection with the reader.
This could be an indication that the connection to the reader isn't set up
correctly; see the troubleshooting for help resolving this error.

Reader Data Uploaded to HandNet: Someone used Upload Users on the Reader
menu to get user information from the reader; see Getting User
Information from a Reader on page 99.

Reader Deleted: A reader was deleted from HandNet.

Reader Properties Changed: Someone went to the Reader Properties and
changed the settings on one of the tabs there. HandNet doesn't keep
track of which settings were changed.  For more about reader
properties, see page 45

Record Imported for Creation: An new user was added to HandNet by the
import process.

Record Imported for Deletion: A user that was already in HandNet was
deleted based on information in the import file.
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Record Imported for Modification:  A user that was already in HandNet was
changed to match a user with the same ID in the import file.

Record Imported, Empty Template Overwrote Local Enrollment:  A user that
wasn't enrolled was imported.  This replaced an enrolled user, so the
user is not longer enrolled in HandNet.  You can prevent enrolled users
by being replace by either preventing the exporting computer from
exporting users that aren’t enrolled yet, or by changing the import
settings so non-enrolled users can’t replace enrolled ones; see the
explanation for the import/export settings on page 28.

Reject Override Changed: Someone changed the reject threshold for an
individual user using the command menus in the reader. Generally this
setting is controlled in HandNet with the Override setting on the
Security screen in User Properties; HandNet users wouldn't typically
change this at the reader. (If you change this or other user settings in
HandNet, you just see the message User Properties Changed.)

Reject Threshold Set: Someone changed the reject threshold using the
command menus in the reader. Generally this setting is controlled from
HandNet using Reject Threshold on the Configuration tab in Reader
Properties rather than from the reader. (If you change this or other
settings for the reader in HandNet, you just see the message Reader
Properties Changed.)

Remote Enrollment Started: A user was enrolled with the Enroll option on the
Reader menu. (For users enrolled from the command menu on the
reader, you see the message User Enrolled.)  See page 88 for more about
enrolling users.

Report Engine Unavailable: You should never see this message.

Request to Exit Activated: A user has pressed the request to exit button in
order to get out of the secure area.

Score Is: You should never see this message.

Site Added: A site was added to HandNet.

Site Code Changed: The site code was changed using the command menus in
the reader.

Site Connected: HandNet is set up to connect with the site by modem, and
HandNet connected to the site.

Site Deleted: A site was deleted in HandNet.

Site Disconnected: HandNet is set up to connect with the site by modem, and
HandNet disconnected from the site when it was done communicating
with the site.

Site Properties Changed: In HandNet, one or more changes were made to the
Site Properties.  For more about site properties, see page 34.

Special Enrollment: The command menus in the reader was used to enroll a
user who does not require hand recognition to gain access. 

Supervisor Override: You shouldn't see this message.
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System Re-calibrated: Someone recalibrated the reader; see page 126.

System Settings Changed: Someone changed one or more entries on one of the
System Settings tabs that you get to with Settings on the View menu.
For more about system settings, see page 22.

Tamper Activated: Someone has shaken the reader roughly or has opened the
reader. Unless someone was servicing the reader, this message
generally warrants further investigation.

Time and Date Set: Someone changed the time and date in the reader using
the command menus in the reader. (Generally, rather than changing
date and time in the reader, you would just make sure that the date and
time were correct in the computer and then send the date and time to
the reader using Download Time on the Reader menu.) 

Time Restrictions Turned On/Off For All Users: You shouldn't see this message.

Time Zone Data Changed: Someone changed a time zone using the command
menus in the reader. Generally this setting is controlled with the Time
Zone settings in HandNet and not changed at the reader. (If you change
time zones in HandNet, you see the message Time Zones Changed.)

Time Zones Changed: In HandNet, someone changed Time Zones.  See
page 62 for more on setting up time zones.

Two Man Timeout: Two people were required to verify at the reader, and they
have not done so within the permitted time period.

Unable to Close Communications Port: HandNet was unable to close the serial
communications port.

Unable to Install Communications Port or Unable to Open Communications Port:
You get this message if HandNet tries to establish communication with
a reader through a serial port and it can't. Generally this only happens
if you are running another program that is already controlling that
serial port. You can't have two different devices connected to the same
port, so if a reader really is connected to that port, nothing else should
be. Either you have selected the wrong port on the Connection tab in the
Site Properties, or the other program that you are running has the
wrong port selected. If you were previously running another program
(especially one trying to connect to a modem, fax, or printer), it is
possible that the other program tried to use the port and didn't close it
properly. Make sure that other programs that might try to control the
port are closed.  If the problem still exists, trying shutting everything
down and restarting the computer.

Unable to Retrieve Datalog: An attempt to get information from the reader
failed.

Unauthorized Enrollment Attempted: Someone tried to enroll a user at a reader
and the user hadn't been added to HandNet yet. Your settings don't
allow this. (To change your settings so this is allowed, check the box by
Do not delete unauthorized enrollments on the Security tab in System
Settings; see page 23.)
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Unit Address Changed: Someone changed the address of the reader using the
command menus in the reader.

User Added From Card: You shouldn't see this message.

User Database Field Added: Someone went to the Custom tab in the User
Database Properties and added a new custom entry; see page 97.

User Database Field Deleted: Someone went to the Custom tab in the User
Database Properties and removed a custom entry.

User Database Import Finished: The process of importing users (from the
import.mdb file) is done.

User Enrolled: A user was enrolled using the command menu on the reader.
(For users enrolled with the Enroll option on the Reader menu, you see
the message Remote Enrollment Started.)  See page 88 for more about
enrolling users.

User Record Added: A user was added in HandNet.

User Record Changed: User Properties were changed for a user in HandNet.
The change could be on any of the three tabs of user information.  See
page 90 for more on user properties.

User Record Deleted: A user was deleted in HandNet.

User Removed: A user was removed using the command menus in the
reader. A user who was removed in this way is only removed from that
one reader; the user isn't removed from HandNet or from any other
reader. If you ever download users to a reader, the user will be added to
the reader again if the user is still in HandNet. (To remove a user from
HandNet, click the user on the list of users and press the DEL key.
Removing a user from HandNet generates the message User Record
Deleted.)

Users Listed: Someone listed users using the command menus in the reader.
(If you want a list of users, it's generally much easier to just look at the
list of users in HandNet or to print the Users report; see page 13.)

Users Time Zone Changed: When a user can access the reader was changed
from the command menus in the reader. (Typically, this isn't changed
at the reader; you would instead change the user's access profile on the
Security tab in User Properties to change when the user has access to
particular readers.  If you did this, you would see the message User
Properties Changed.)
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Reader Maintenance
Cleaning
Readers

You should periodically clean hand readers; if you don't, users may get
rejected more often.

Spray any ordinary, non-abrasive cleaner on a clean cloth, and then use the
cloth to wipe the platen, the mirror and reflector on the sides of reader, and
the window above the platen.  When wiping the platen, start from the back
corners and wipe forward.

Never spray cleaning fluid directly onto the reader!  Always spray a
cloth and then wipe the reader with the cloth.

Never use an abrasive or gritty cleaner!  An abrasive cleaner could
scratch the reader; this would damage it.

Recalibrating
Readers

If users are often being rejected at a particular reader, try recalibrating it.
To do this:

1. Check the list of users to make sure you have an Authority Level of 1
or higher.  If you have an authority level of None, you can't do this.
(To change your authority level, double-click your name on the list of
users, click the Security tab, click the Authority Level entry, and select
the appropriate level.)

2. Go to the reader to be recalibrated, and enter command mode on the
reader:

If you have a HandKey II or HandKey CR reader:  Press CLEAR, and then
press ENTER.

If you have an ID3D HandKey reader:  Press # AND *.  (You can press
them at the same time, or one after the other.)

The display on the reader should look like this:

3. Type your User Id number (the same one you enter to get access
through the reader), and press ENTER or #.  The reader asks you to place
your hand.  Once it recognizes your hand, this display looks like this:

4. Type 1 (one) and press ENTER or #.  (This is the standard password for
the Service menu in the reader; if you have changed this on the

       READY      
*:

  ENTER PASSWORD
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Passwords screen in the Reader Properties, enter the password you
have set up.)  The display should now look like this:

If the reader shows the READY screen again instead of this screen,
either you placed your hand improperly or you don't have the rights to
do this; carefully check step one again.

5. Press the YES / # button.  This display should now look something like
this:

(The actual numbers on the first line may be different.)
6. Press the YES / # button again.  After telling you to please wait, you will

see the Calibrate No/Yes display again.  At this point, the reader should
be recalibrated.

7. Press the CLEAR button to leave the Service menu and return to the
reader to its normal display.
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Making Backups
Why Make

Backups
Occasionally computer hard drives fail, losing the information on them.
Occasionally computer files get damaged, making the information in them
unusable.  And occasionally computer users make mistakes and delete
information they shouldn't.  A backup is an extra copy of the information on
your computer, so that if the information gets damaged or lost, you have
another copy to protect you.

The information in HandNet—information about readers, access profiles,
and users—represents many hours of work.  The record of activity
(including archived historical activity) is often an important security record.
So you should protect your many hours of work by periodically making a
backup copy of this information.

Making
Backups a
Scheduled

Event

In practice, many computer users understand that backups are important,
but they still go months or even years without actually making one.  Then,
when a problem occurs, the backup they have is so old that it doesn't save
them all that much work.  The way to avoid this is to make backing up your
information a scheduled part of your routine.  How often you need to make
them depends on how many changes to the information you make.  If you
are continually adding and removing users, a weekly backup might be
appropriate.  If you make fewer changes and losing a month's changes
wouldn't be that hard to redo, a monthly backup might be enough.
Regardless, decide how often to make a backup, and then put it on your
calendar; do it every Friday morning, or every month before you print your
activity reports.  If you don't schedule backups, they probably won't happen.
And if you don't make them, sooner or later most computer users regret it.

How to Make a
Backup of

Your HandNet
Information

You should periodically be making backups of all the information on your
computer.  How to best do that is beyond the scope of these instructions.
Here, we'll just tell you how to make a backup of your HandNet information.

1. Use Windows Explorer to go to the folder HandNet is in.  (If you
installed HandNet in the standard location, it is in C:\Program
Files\Recognition Systems, Inc\HandNet for Windows.)

2. Make a copy of all of the Microsoft Access Database files (*.MDB) and
all of the HandNet Activity Archive files (*.HNA) in this directory.  You
can copy these files to a floppy disk or to a network drive.  If the files are
large, WinZip is a helpful and inexpensive utility that lets you both
compress a number of files into a single archive and spread the archive
over a number of disks if needed.  (To get WinZip, go to
www.winzip.com.  For help making an archive span several floppy
disks, look up “spanning” in the index of WinZip's help.)

The best protection is to store the backup disks in a different place than the
computer.  That way, if the computer is damaged by fire or water, or if the
computer equipment is stolen, there's no chance of the backup disks being
damaged or taken.
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Reporting and Exporting Information
Printing or

Viewing
Reports

Whenever you generate a report, HandNet shows the report in a new
window.  The header of that window lets you move from page to page, print
the report, or export the report to a file.  The header looks like this:

To print the report:  Click the printer icon near the middle of the header to
print the report.

If the printer icon is disabled and grayed-out, you don’t have a printer
set up yet on this computer.  (To set up a printer, go to the Windows
Start menu, highlight Settings, pick Printers, and click Add Printer.)

To export the report to a file:  Click the icon with the envelope.  You can export
to a variety of formats including Word, Excel, Lotus 1-2-3, rtf, text, and
others.

To close the report window when done:  Click the X in the upper-right corner
of the window.

Getting
Information

from HandNet
Database Files

HandNet for Windows stores information in access database files
(actions.mdb, activity.mdb, and HandNet.mdb).  These files are password
protected for security; we do NOT ever give these passwords out for any
reason.  If we did, it would put the integrity of your security at risk.

Exporting
activity to an

access
database file

However, HandNet can export activity to an access database file that is not
password protected so you can open it and access any information in it at
will.  If you want to create custom activity reports using some external
report tool, Export Activity on the File menu sends all of your current
activity to an access database file called expactvt.mdb.

Exporting the
content of

any report to
various
formats

To save HandNet information to a file, you can also generate any
Activity Report or other report on the Reports menu and, when you
see the report on the screen, click the Export button.

You will then be able to save the content of the report in a number of
different formats so you can import it into other programs.  These formats
include:  character-separated values, comma-separated values, Crystal
Reports, Data Interchange Format (DIF), Excel (versions 5.0, 7.0, or 8.0;
either extended or not), Lotus 1-2-3 (WK1, WK3, or WKS), Access 97
database, paginated text, record style (columns of values(, report definition,
Rich Text Format (RTF), tab-separated, text, or Word for Windows.
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Locking and Unlocking Doors
Automatically

Unlocking a
Door on a

Scheduled
Basis

If you regularly want a door unlocked during certain hours:

1. If you haven't already done so, set up a time zone that corresponds to
the days and times you want the door unlocked.

2. Select the reader(s) in the list of readers.
3. Pick Reader from the main menu, and then pick Properties from the

Reader menu.
4. Go to the Configuration tab.
5. In the Auto Unlock Time Zone, choose the time zone when the door

should be automatically unlocked.  HandNet automatically unlocks the
door at the beginning of the time zone, and locks it again at the end of
the time zone.

Unlocking a
Door on a Non-

Scheduled
Basis

Unlock on the Reader menu lets you unlock a door without setting it up to
be regularly unlocked.

1. Select the reader(s) in the list of readers.
2. Pick Reader from the main menu, and highlight Unlock on the Reader

menu.  You'll see another menu with two choices:  Indefinite and Timed.  

To unlock a door so that it stays unlocked until you lock it again:  Choose 
Indefinite.  This leaves the door unlocked until you lock it again 
with Relock on the Reader menu.  

To unlock the door momentarily:  Choose Timed.  This unlocks the door 
connected to that reader only for the number of seconds specified in 
Lock Open For on the Configuration tab in the Reader Properties.  
(That is, it unlocks the door for the same number of seconds that 
the door would be unlocked if it were opened by a reader.)

Locking a
Door so it can't

be Opened
from the

Reader

Lockup on the Reader menu disables the lock on the door for the selected
reader.  The reader will still let users enter their ID numbers and still verify
hands, but the door will stay locked and will not open even for valid users.
No one will be able to open the door from the reader until you choose Unlock
or Relock from the Reader menu.

Locking an
Unlocked Door

If you have unlocked a door with Unlock, Indefinite on the Reader menu,
Relock locks it again.  (If you unlocked the door using Unlock, Timed on the
Reader menu, the door automatically relocks after the number of seconds
specified in Lock Open For on the Configuration tab in the Reader Properties
just as it would if the door were unlocked by the reader, so you don't have to
anything special to relock it.

If you have disabled access through a door with Lockup on the Reader menu,
Relock releases so the reader can open it again.
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Turning an Auxiliary Device On or Off
HandNet can be set up to automatically turn on external auxiliary devices
when certain conditions occur.  For example, it might trigger an alarm, turn
on lights or a security camera, and so on.

HandNet can turn an auxiliary device on automatically when certain
conditions occur.  When this can happen is controlled by the Auxiliary
(AUX) Settings tab; see page 49.  (The HandKey II and HandKey CR
support up to three auxiliary devices; this option only controls the first of
these, the same one controlled by the Auxiliary Settings tab in Reader
Properties.  The other two are only controlled by the Extended Settings tab
in Reader Properties.)

Manually
Turning an

Auxiliary
Device On

Auxiliary Output on the Reader menu lets you turn manually turn an
auxiliary device on or off without anything happening at the reader.  For
example, suppose a reader, in addition to being connected to a door, is also
connected to an auxiliary light.  You could use this option to turn the light
on without doing anything at the reader.

To turn on an auxiliary device that is connected to a reader:

1. Click a reader in the right pane of the Network window.  (If the
Network window isn’t shown, press CTRL-N to open it.)

2. Click Reader from the main menu bar at the top of the screen.
3. Click Auxiliary Output on the Reader menu, and then click On.

Manually
Turning an

Auxiliary
Device Off

If you have manually turned an auxiliary device on, or if an alarm condition
has turned it on, you can also turn the device off from HandNet.  For
example, suppose an auxiliary alarm is connected to the reader, and
suppose the alarm is set to sound for 15 minutes after the condition occurs.
You could use this option to turn the alarm off before the 15 minutes was
done.

To turn off an auxiliary device that is connected to a reader:

1. Click a reader in the right pane of the Network window.  (If the
Network window isn’t shown, press CTRL-N to open it.)

2. Click Reader from the main menu bar at the top of the screen.
3. Click Auxiliary Output on the Reader menu, and then click Off.
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Troubleshooting

Answers to Common Questions

Enroll Option
Disabled

If the Enroll option on the Reader menu is disabled or grayed out, there are
several possible reasons.  Check each of the following:

1. Make sure you are logged in.  If you aren't logged in, you can't change
anything.

2. Make sure that you have selected a reader on the list of readers.  Since
enrollment has to be done at a reader, you must pick the reader to enroll
at before the enroll option will work.  (To see the list of readers, type
CTRL N or pick Network from the View menu.)

3. Pick About HandNet for Windows... from the Help menu.  Check the
bottom of the box that pops up.  To be able to use the enroll feature, the
last line must say You may use all features of this software.  If this line
says Your current license does not let you use the enroll...., you must
contact your dealer and upgrade your license before you can use this
feature.  (Once you upgrade, we will send you an access code that makes
the feature available.)  If you don't upgrade to the full feature set, you
must start the enrollment process using the command menus in the
reader; see page 88.

4. Check with your supervisor to see if you are authorized to enroll users.
(For you to be authorized to enroll users, Reader Data Download must
be checked in the Access Rights for the Operator in System Settings.)

No Current
Record

Message

You get the message “No Current Record” when you start HandNet if you
haven't added any users yet.  This message stops occurring once you add a
user.  See page 75 and following for help adding users.

Problems
Connecting to

a Site by
Modem

If you are having trouble getting HandNet to connect to a site by modem,
check each of the following:

1. Click the site in the left pane of the Network window, pick Properties
from the Site menu, and click the Connection tab.

2. Make sure you have picked the serial port that the modem is connected
to; if this is set to none, HandNet won't connect.

3. Make sure the Baud Rate in Site Properties in HandNet matches the
baud rate the reader is set up for.  We recommend 9,600 for a HandKey
II or HandKey CR and 2400 for a HandKey reader.

4. Make sure the phone number is entered correctly.  If you have to dial
some digit to get an outside line, enter this digit followed by a comma
before the phone number.  If the number is a long distance number,
make sure you have entered the 1 and the area code as appropriate.  For
example, if you had to dial a 9 for an outside line, and the number was
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a long distance call that required by 1 and an area code, you would enter
the number like this: 

9, 18025551212
5. Make sure the modem is hooked up to a phone line.
6. Make sure the phone line is plugged into the right jack on the modem

connected to your computer.  (Most modems have two jacks: one labeled
“Line” and one labeled “Phone.” The phone wire from the phone jack on
the wall must connect to the jack on the modem labeled “Line.”

7. Make sure the phone line has a dial tone.  (Hook up a regular phone to
the modem jack labeled “phone” to see if you hear a dial tone; if you
don't, there's a problem with the jack or phone line.)

8. Make sure no other phone, fax machine, or modem is trying to use the
same phone line.

9. Make sure call waiting isn't on for this line.
10. On the Schedule tab in Site Properties, make sure you have set up a

time for this site to connect.  Make sure this connection time is enabled
(checked).

Program
Claims to be a

Demonstration
Version

When HandNet for Windows is installed, it is in demonstration mode:  it
gives you full functionality for 14 days, and after that it limits the use of
certain features.

If you purchased a previous version of HandNet for Windows, you are also
authorized to use this version, but you must register it first, even if you
registered your previous version.  Once you send us your registration
information, we'll give you an authorization code that makes the program
permanently functional.

To register this copy of HandNet, please pick Registration from the File
menu and follow the instructions on that screen.  (We would just repeat the
instructions here, but you need the unique ID number that is shown on that
screen and you also need to print the registration form.)

If you really do have a demonstration version, please contact us to find out
how to purchase a full version.

Software
Expired

After the first time you use this version of HandNet, you have 14 days to
register it.  You must register even if you registered your previous version
of HandNet.  If you don't register within 14 days, you won't be able to log in.
When you try to log in, you see this message:

If you get this message, exit HandNet and then restart HandNet.  This
brings up the registration screen.  Send us the information requested on
that screen.  Once we get your information, we'll send you an activation code
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to enter on the registration screen.  This will make HandNet permanently
functional.

Unable to
Acknowledge

an Alarm

If you have opened the detail box for an alarm and the Acknowledge buttons
are disabled or grayed out, check the following:

1. Make sure you are logged in.  If you aren't logged in, you can't change
anything.

2. Make sure that you are clicking one of the Acknowledge buttons at the
bottom left of the window; you can't just click the checkbox by the word
acknowledged; you must click one of the buttons.

3. Check with your supervisor to see if you are authorized to acknowledge
alarms.  (For you to be authorized to acknowledge alarms, the Alarm
Acknowledgement box must be checked in the Access Rights for the
Operator in System Settings; see page 24 for more on adding or
changing operator settings.)

User Often
Rejected

If a user is often rejected at readers, you may need to teach the user the
correct way to place the hand on the platen; see Teaching Users How to
Place Their Hands on Readers on page 87.

Creating a
new profile of

the user's
hand

If the user held his/her hand improperly while being enrolled, or if the user
has lost or gained a lot of weight, the hand profile may be different enough
to prevent recognition.   Delete the user (this eliminates the old hand
profile), and then add the user again.  When you re-enroll the user, this
creates a new profile of the hand.  Make sure the user correctly places his/
her hand.  You can usually avoid this situation by allowing HandNet to
update the user’s hand profile each time the user gains access; see page 23.

If the user
has a

disability that
prevents

consistent
hand

placement

You may need to increase the tolerance for the user.  To do this:

1. Double-click the user on the list of users. (You could also click once to
select the user and then pick Properties from the User menu.)

2. Click  the Security tab.
3. Check the Override Reader's Threshold box if it isn't already checked.
4. Drag the pointer to the right (the Less Sensitive side).

If many users
are rejected

at a particular
reader

If many users are being rejected at a particular reader, you may need to
clean the reader or you may need to recalibrate it; see page 126.
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